
classroom in a book®

The official training workbook from Adobe

Lightroom and Photoshop  
for Photographers

Adobe

Instructor Notes



Adobe® Lightroom® and Photoshop® for Photographers Classroom in a Book®, Instructor Notes

© 2015 Adobe Systems Incorporated and its licensors. All rights reserved.

If this guide is distributed with software that includes an end user license agreement, this guide, as well as 
the software described in it, is furnished under license and may be used or copied only in accordance with 
the terms of such license. Except as permitted by any such license, no part of this guide may be repro-
duced, stored in a retrieval system, or transmitted, in any form or by any means, electronic, mechanical, 
recording, or otherwise, without the prior written permission of Adobe Systems Incorporated. Please 
note that the content in this guide is protected under copyright law even if it is not distributed with soft-
ware that includes an end user license agreement.

The content of this guide is furnished for informational use only, is subject to change without notice, and 
should not be construed as a commitment by Adobe Systems Incorporated. Adobe Systems Incorporated 
assumes no responsibility or liability for any errors or inaccuracies that may appear in the informational 
content contained in this guide.

Please remember that existing artwork or images that you may want to include in your project may be 
protected under copyright law. The unauthorized incorporation of such material into your new work 
could be a violation of the rights of the copyright owner. Please be sure to obtain any permission required 
from the copyright owner.

Any references to company names in sample files are for demonstration purposes only and are not 
intended to refer to any actual organization.

Adobe, the Adobe logo, Lightroom, Photoshop, and Classroom in a Book are either registered trademarks 
or trademarks of Adobe Systems Incorporated in the United States and/or other countries.

Adobe Systems Incorporated, 345 Park Avenue, San Jose, California 95110-2704, USA

Notice to U.S. Government End Users. The Software and Documentation are “Commercial Items,” as that 
term is defined at 48 C.F.R. §2.101, consisting of “Commercial Computer Software” and “Commercial 
ComputerSoftware Documentation,” as such terms are used in 48 C.F.R. §12.212 or 48 C.F.R. §227.7202, 
as applicable. Consistent with 48 C.F.R. §12.212 or 48 C.F.R. §§227.7202-1 through 227.7202-4, as applica-
ble, the Commercial Computer Software and Commercial Computer Software Documentation are being 
licensed to U.S. Government end users (a) only as Commercial Items and (b) with only those rights as are 
granted to all other end users pursuant to the terms and conditions herein. Unpublished-rights reserved 
under the copyright laws of the United States. Adobe Systems Incorporated, 345 Park Avenue, San Jose, 
CA 95110-2704, USA. For U.S. Government End Users, Adobe agrees to comply with all applicable equal 
opportunity laws including, if appropriate, the provisions of Executive Order 11246, as amended, Section 
402 of the Vietnam Era Veterans Readjustment Assistance Act of 1974 (38 USC 4212), and Section 503 
of the Rehabilitation Act of 1973, as amended, and the regulations at 41 CFR Parts 60-1 through 60-60, 
60-250, and 60-741. The affirmative action clause and regulations contained in the preceding sentence 
shall be incorporated by reference.

Adobe Press books are published by Peachpit, a division of Pearson Education located in San Francisco, 
California. For the latest on Adobe Press books, go to www.adobepress.com. To report errors, please send 
a note to errata@peachpit.com. For information on getting permission for reprints and excerpts, contact 
permissions@peachpit.com.

Author: Jan Kabili 
Project Editor: Nancy Peterson 
Development Editor: Robyn G. Thomas 
Proofreader: Liz Welch 
Production Coordinator and Compositor: Tracey Croom 
Cover Designer: Eddie Yuen 
Interior Designer: Mimi Heft

Printed and bound in the United States of America

Book: 
ISBN-13: 	 978-0-133-81671-6 
ISBN-10: 	 0-133-81671-0

Instructor Notes: 
ISBN-13: 	 978-0-133-81685-3 
ISBN-10: 	 0-133-81685-0

9 8 7 6 5 4 3 2 1



Adobe Lightroom and Photoshop for Photographers Classroom in a Book  3

Instructor Notes
Introduction
Adobe Lightroom and Photoshop for Photographers Classroom in a Book 
provides students with solutions and techniques for using Adobe Lightroom 
and Adobe Photoshop software to process their photographs. These instructor 
notes complement that book, providing instructors with behind-the-scenes 
information and insights.

These instructor notes are sequenced to follow the lessons in Adobe Lightroom and 
Photoshop for Photographers Classroom in a Book.

About the Classroom in a Book

We recommend that each student in the class have an individual copy of Adobe 
Lightroom and Photoshop for Photographers Classroom in a Book. Students will use 
the book as you lead them through projects. Alternatively, students can use the 
book as a self–paced tutorial to complement your classroom instruction. 

Course strategy

The book contains nine lessons, including the “Getting Started” lesson. If you’re 
teaching a 10-session course, you can teach one lesson per session, reserving 
the final session for review and critique of students’ work. If you’re teaching a 
16-session course, you can teach one lesson every other session, interspersing the 
instructional lessons with practice sessions.

Classroom requirements

Install Lightroom 5 or later, Photoshop CC or later, and the latest Camera Raw 
plug-in for your version of Photoshop on each classroom workstation. At home, 
students can use older versions of the software back to Lightroom 4 and Photoshop 
CS6, although some of the exercises in the book will not work the same way in 
older software versions.

Each workstation should meet Adobe’s minimum system requirements for the 
software, as described in Adobe’s help files:  
https://helpx.adobe.com/lightroom/system-requirements.html  
https://helpx.adobe.com/photoshop/system-requirements.html

Each student should have a digital camera memory card reader and memory card 
for use in Lesson 1, “Importing from a camera.”
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Managing student projects

The “Getting Started” lesson instructs each user to create a folder named LPCIB to 
contain both the lesson files and a Lightroom catalog for those files. To simplify file 
storage and retrieval in the classroom environment, include the student’s name in 
the title of that folder: student name LPCIB. The work a student produces during 
the course will be located inside that folder, both in the Lightroom catalog that 
resides in that folder and in derivative photographs generated by using Lightroom 
and Photoshop together. (Derivative photographs are versions of files saved from 
Photoshop during the Lightroom–Photoshop roundtrip workflow. They are auto-
matically saved to the same location as the original photographs from which they 
are derived, as explained in Lesson 2.)

Store each student name LPCIB folder on the student’s workstation or on an exter-
nal drive, rather than on a server or network drive. Adobe does not recommend 
storing and using Lightroom catalog files on a network.

You can view and evaluate a student’s work during the course by opening the 
Lightroom catalog located in that student’s student name LPCIB folder. If you want 
to view a student’s work on another computer (the instructor computer), copy the 
entire student name LPCIB folder from the student’s classroom workstation to the 
instructor computer or to an external drive. Launch the Lightroom application on 
the instructor computer while holding the Alt/Option key. In the Select Catalog 
window that opens, select the copy of the LPCIB Catalog.lrcat file that is on the 
instructor computer or external drive and click Open. Lightroom may indicate that 
files and folders are missing, because this catalog is still linked to the files on the 
student’s classroom workstation. However, you can still view and evaluate missing 
images from the instructor computer. 

If for some reason you want to make Develop module adjustments to missing 
images from the instructor computer, you must re-link the images. To do that, go 
to the Folders panel in the Library module on the instructor computer, right-click/
Control-click the question mark on the top-level folder that contains the lesson 
files (the Lessons folder), and choose Find Missing Folder. In the window that 
opens, navigate to the student name LPCIB folder > Lessons folder you copied 
to the instructor computer or external drive. For more on re-linking missing files 
and folders, see the “Moving a folder and files outside Lightroom” sidebar and 
“Re-linking missing files” section in Lesson 3.
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Getting Started
The Getting Started lesson is an important one to cover with your students for 
two reasons:

•	 This chapter explains when and why to use Lightroom and Photoshop together.

•	 This chapter includes some of the logistics for the provided lesson files. It 
explains where to find the lesson files, how to download them, and how to 
create a Lightroom catalog for use with those files.

Why to use both Lightroom and Photoshop

Emphasize that there are good reasons to use both Lightroom and Photoshop 
rather than rely exclusively on either one of these applications. 

Explain how the two applications differ in terms of their purpose and structure:

•	 Lightroom is a photo-centric application, designed to meet the needs of 
photographers. Photoshop is used not only by photographers, but by other 
creative professionals too. This fact affects the features available in each 
program. For example, Photoshop has compositing, graphics, and retouching 
capabilities you won’t find in Lightroom.

•	 Photoshop is focused on image editing. Lightroom addresses other aspects 
of a photographer’s workflow too, from importing and organizing photos to 
outputting and sharing photos. 

•	 Lightroom offers efficient ways to process lots of photographs relatively quickly. 
Photoshop’s many editing options make it ideal for fine-tuning a single image.

•	 Photoshop is a pixel editor; it changes an image by altering its pixels. Lightroom 
is a parametric editor. This means that Lightroom does not alter pixels; it simply 
keeps track of information about a photograph, including all editing parameters 
that you adjust in the Develop module. This has many practical consequences 
for working in the two programs. For example, there is no Save command 
in Lightroom like there is in Photoshop, because the changes you make in 
Lightroom are automatically recorded in the Lightroom catalog. 

Explain that the differences in Photoshop and Lightroom cause each program 
to excel at different tasks, and the ideal workflow is one that takes advantage of 
the strengths of each application. Introduce the kinds of tasks that are best done 
in Lightroom and those best done in Photoshop. These are summarized in the 
“Getting Started” lesson and detailed throughout the book.
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Lightroom’s strengths include:

•	 Photo management and organization

•	 Conversion of raw files

•	 Streamlined photo processing

•	 Batch processing multiple photographs

•	 Outputting and sharing photographs

Photoshop’s strengths include:

•	 Combining photographs

•	 Precise photo adjusting using selections and masks

•	 Retouching and removing content

•	 Adding text, graphics, and special effects

Downloading the lesson files

Sample image files, called lesson files, are provided for use with the exercises in the 
book. Download a copy of the lesson files to each classroom workstation, follow-
ing the steps in “Downloading the lesson files” in the book. You have the option to 
download a Lessons folder that contains all the lesson files for the entire book or 
lesson files for individual chapters. 

Store the lesson files on each workstation and in the folder structure detailed in this 
section of the book, with one exception for the classroom environment: This sec-
tion of the book suggests creating a folder titled LPCIB to hold the lesson files and 
Lightroom catalog. Instruct each student to include his or her name on that folder 
(student name LPCIB), as recommended earlier in this guide in “Managing student 
projects.” This will help you identify a particular student’s work during the course.

Creating a Lightroom catalog for use 
with this book (and course)

Explain that a Lightroom catalog is a database that contains a record of each photo-
graph included in the catalog. That record includes data from the digital camera 
with which a photograph was shot, organizing information added in Lightroom, 
and instructions about how a photograph is adjusted in Lightroom. For more on 
catalogs, see “Understanding catalogs” in Lesson 1.

Instruct students to create a separate Lightroom catalog for classroom use by 
following the steps in this section of the book. Executing the steps will generate 
Lightroom catalog files in the student name LPCIB > LPCIB Catalog folder on each 
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student’s classroom workstation. When Lightroom is closed, the catalog files are 
those ending in .lrcat and .lrdata; when Lightroom is open, there are some addi-
tional, temporary catalog files.

At this point the student’s Lightroom catalog will be empty. Wait until the Lesson 1 
section, “Importing from a drive,” to introduce importing lesson files into the cata-
log. This will allow you to use the Lesson 1 files to simulate the process of import-
ing any photographs that are already on a computer drive, which is an important 
real-world step when students are working with their own photographs outside 
of class. 

Have students import files lesson by lesson at the beginning of each of Lessons 2 
through 8. This will reinforce the importing process and give you the opportunity 
to teach individual lessons independently.

Getting Help

The book focuses on using Lightroom and Photoshop together. If you or your 
students want additional help with either application, consult the links and 
resources listed in “Getting Help” in the book.

Help in the Applications
Complete Help documentation is accessible from the Lightroom and Photoshop 
applications when an Internet connection is active. In Photoshop CC, choose 
Help > Photoshop Help. In Lightroom 5, choose Help > Lightroom Help. 

The first time a module is opened in Lightroom, a series of tips specific to that 
module is displayed. Those tips can be displayed again by choosing Help >  
[module name] Module Tips. 

Help on the web
The most comprehensive and up-to-date help for Lightroom and Photoshop is 
located online at:

•	 helpx.adobe.com/lightroom/topics.html

•	 helpx.adobe.com/photoshop/topics.html

Help PDFs
PDFs of Help documentation for Lightroom and Photoshop can be downloaded from:

•	 helpx.adobe.com/pdf/lightroom_reference.pdf

•	 helpx.adobe.com/pdf/photoshop_reference.pdf
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Additional Resources
Other useful resources for Lightroom and Photoshop are listed in “Additional 
Resources” in the book, including resources specifically for educators:  
www.adobe.com/education and edex.adobe.com.

Adobe TV is an excellent online video resource for expert instruction and inspira-
tion about Lightroom, Photoshop, and other Adobe products: tv.adobe.com.

Adobe Learn and Support is a comprehensive resource for tutorials, support, and 
new feature information: helpx.adobe.com/support.html.
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Lesson 1:  
Getting Ready to Use Lightroom  
with Photoshop
This lesson is about preparing to use Lightroom and Photoshop together. It covers 
Lightroom’s catalog system, where to store photographs for use with Lightroom, 
importing photographs into Lightroom, and setting up Lightroom and Photoshop 
so they work together smoothly.

Preparing for this lesson

This section instructs students how to launch Lightroom at the beginning of each class-
room session. Although there are other ways to launch Lightroom, encourage students 
to use this method in class to ensure they are working in the correct catalog for your 
course—the LPCIB catalog they created earlier in the “Getting Started” lesson.

Understanding catalogs

Explain that a Lightroom catalog is a database containing information (metadata) 
about the photographs you choose to include in that catalog. The catalog does not 
contain actual photographs—a common misconception.

An effective teaching tool is to compare a Lightroom catalog to a card catalog in a 
traditional library. A library card catalog contains a card, or record, for each book 
in the library system. That card contains information about the book, including 
where it is located. Obviously, the books themselves are not inside the card catalog; 
a particular book may be on a shelf in the library or perhaps off-site. 

Similarly, a Lightroom catalog contains a record of each photograph in the catalog, 
including a link to the location where the photograph is stored. This record also 
contains information from the camera with which the photograph was shot (like 
camera settings, date and time, and more), and descriptions of everything added 
to the photograph in Lightroom (such as keywords, Develop module adjustments, 
and more). The photograph itself is not located inside the Lightroom catalog; it is 
located in a folder on the computer or perhaps on an external drive. The Lightroom 
catalog keeps track of that location even if the photograph is on a different drive 
than the catalog and even if the photograph is on a drive that is currently offline. 

Have students look inside their student name LPCIB > LPCIB Catalog folder to see 
the .lrcat and .lrdata database files that make up the Lightroom catalog. Emphasize 
that these catalog files are separate and distinct from the photographs they’ll include 
in the catalog, which are located in the student name LPCIB > Lessons folder.
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How many catalogs to use
Clarify to your students that although they have made a separate catalog for 
this course, it’s good practice outside of class to use a single catalog for all their 
photographs. A single catalog is easier to manage and facilitates finding particular 
photographs, because Lightroom can search only one catalog at a time.

Storing your photographs

Help students manage their personal photographs outside of class by offering 
these tips:

•	 Photographs do not have to be stored on the same drive as the Lightroom 
catalog. It’s common to store photographs on one or more large external drives 
and keep the relatively small catalog files on a computer. 

•	 Organize existing photographs into folders before importing them into 
Lightroom. This may take some time, but the effort will pay off later in 
Lightroom with a well-organized folder structure in Lightroom’s Folders panel 
that will be easy to build upon as new photographs are imported. There is no 
special, required folder structure. To see an example of a simple date-based 
folder structure that many photographers use, open the Lesson 1 folder outside 
of Lightroom.

•	 Put all the folders of photographs inside one top-level folder and give that folder 
an inclusive name like Lightroom Photos. This will make it easier to relocate 
the photos to a larger drive if and when they outgrow the current drive. At 
that point, just copy the Lightroom Photos folder to a larger drive and point 
Lightroom to the copy (by right-clicking/Ctrl-clicking the Lightroom Photos 
folder in the Folders panel, choosing Update Folder Location, and navigating to 
the copy of the Lightroom Photos folder on the larger drive). 

Importing photographs into Lightroom

Importing is a prerequisite to working with the lesson files or any photographs 
in Lightroom. Explain that importing does not bring actual photographs into 
Lightroom, as the term import implies. Rather, importing creates a record of photo-
graphs in a Lightroom catalog. 

This section covers two import methods: importing existing photographs from a 
drive, and importing new photographs from a digital camera. We suggest you teach 
the simpler process of importing from a drive first, using the Lesson 1 files. Then 
teach importing from a digital camera, using camera memory cards that students 
bring to class.
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Importing from a drive
This section walks students through importing photographs that have already 
been offloaded from a digital camera to a computer or external drive. When 
Lightroom “imports” these photographs, it simply makes a record of them in 
the Lightroom catalog.

Students will import the Lesson 1 files located on their workstations into the 
LPCIB catalog created in the “Getting Started” lesson.

Teaching the process of importing from a drive is important for two reasons:

•	 This is the method students will use outside class to import photographs 
from their own drives into their own Lightroom catalogs. The Lesson 1 files 
are organized into folders to represent how they might organize their own 
existing photographs.

•	 This is the method students will use at the beginning of each subsequent lesson 
to import the files for that lesson.

Lightroom’s Import window is large and offers many options. As you work through 
this window with students, simplify it by breaking it down into three areas: source 
settings in the left column, import method settings in the bar at the top of the cen-
ter section, and additional options in the right column. 

Explain that Add is usually the best import method for importing photographs that 
have been organized on a drive, because it leaves them where they are, without 
moving or copying them, and just adds a record of them to the catalog. In this 
exercise, choosing the Add method ensures that the lesson files will remain in the 
student name LPCIB > Lessons folder.

Importing from a camera
This section covers importing photographs from a camera’s memory card. When 
Lightroom imports these photographs, it does two things: It offloads the photo-
graphs from the memory card to a designated drive, and it makes a record of them 
in the Lightroom catalog. 

There are no lesson files for this exercise. Instead, ask each student to shoot some 
photographs with a digital camera and bring the camera and its memory card to 
class. A compatible memory card reader or cable will be necessary to import these 
photos to the student’s classroom workstation.

The only available import methods for importing photographs from a camera are 
Copy and Copy as DNG. This exercise uses the Copy method. Copy as DNG is 
explained in a sidebar in the “Importing from a drive” section. 

Point out that there are more panels and options on the right side of the Import 
window when importing from a camera than when importing from a drive, 
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including the To field at the top of the right column, the File Renaming panel, and 
the Destination panel, each of which is addressed in this section.

Note that the default settings in the Import window’s Destination panel automati-
cally import photographs into subfolders labeled by shoot date. The instructions 
in this section suggest alternative destination settings that allow customizing the 
import destination folder. Have each student customize the destination settings 
to suit the particular photographs they are importing. The destination a student 
chooses is not critical, because these photographs are not used again in the lessons 
in the book.

Preparing Lightroom and Photoshop for integration

This section covers technical prerequisites for using Photoshop and Lightroom 
together: setting Lightroom preferences, setting Photoshop preferences, choosing 
Photoshop Color Settings, and keeping Lightroom and Camera Raw updates in sync. 

You’ll see the terms RGB file and RGB image used in this section and throughout 
the book. These terms refer to TIFF, PSD, and JPEG format files, as distinguished 
from raw files. This distinction is important, because raw files and RGB files are 
treated differently in the Lightroom–Photoshop roundtrip workflow, as covered in 
Lesson 2.

Setting Lightroom’s External Editing preferences
Lightroom’s External Editing preferences control image properties with which 
files are passed between Lightroom and Photoshop. It’s important to go over these 
preferences with students now, because these preferences affect the behavior of 
Lightroom and Photoshop throughout the rest of the course. 

Configuring primary external editor preferences

The first section of Lightroom’s External Editing preferences contains the primary 
external editor preferences, which are the most important preferences for purposes 
of this course. These preferences determine initial image properties with which 
files open into Photoshop when it is used as Lightroom’s primary external editor. 
The primary external editor is the default editor to which Lightroom passes files. 
It is listed first in Lightroom’s Edit In menu (the menu used to pass files to external 
editors) and is invoked by the keyboard shortcut Ctrl-E/Command-E.

The latest version of Photoshop installed on a computer automatically becomes the 
primary external editor. 

The steps in this section of the book walk students through setting the properties 
with which the lesson files will open from Lightroom into Photoshop on their class-
room workstations. Use the explanations in each step to discuss the best choice for 
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each setting, which varies depending on use case. The options used for the lessons 
in the book are:

•	 File Format: TIFF

•	 Color Space: ProPhoto RGB

•	 Bit Depth: 16 bit

•	 Resolution: 240

•	 Compression: None

After setting these options, have students hand off a photograph from Lightroom 
to Photoshop as the primary external editor so they can see that the options they 
chose in Lightroom will be applied in Photoshop. The following instructions for 
doing that are supplementary to this section of the book: 

1	 In Lightroom’s Library module, select any Lesson 1 image and press Ctrl-E/
Command-E to open it into Photoshop. 

2	 In Photoshop, click the information area at the bottom of the document 
window and choose Document profile. 

Notice that the color space and bit depth reported there are the same as those 
chosen in Lightroom’s preferences. 

3	 Click that same information area and notice that the resolution reported there 
is the same as the resolution chosen in Lightroom’s preferences. 

The initial color space, bit depth, and resolution are not permanent; they can be 
changed in Photoshop. The file format chosen in Lightroom’s preferences (TIFF) 
does not yet appear in the filename in the document tab, because the rendered 
image exists only in memory until it is saved in Photoshop. 

4	 Choose File > Save and notice that the filename in the document tab now has a 
TIFF suffix. Close the image in Photoshop and return to Lightroom’s External 
Editing preferences.

Configuring Additional External Editor preferences

The Additional External Editor preferences, located in the second section of 
Lightroom’s External Editing preferences, are not critical to the main workflow in this 
course, so feel free to treat this subject lightly in class. The Additional External Editor 
preferences are relevant only if the student has another editor installed in addition to 
Photoshop and is passing an image from Lightroom to the additional editor. 

Setting the stacking preference

The term derivative file is used throughout the book to mean the additional image 
that is generated when a source file is saved from Photoshop during a Lightroom–
Photoshop workflow. 
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The stacking preference in Lightroom’s External Editing preferences affects whether a 
derivative file will appear in a stack with its source file in Lightroom’s Library module 
grid and in Lightroom’s Filmstrip. If students uncheck the stacking preference, advise 
them to set the Sort menu in Lightroom’s Library module toolbar to File Name or 
Capture Time, so derivative files end up near their source files in Lightroom.

Setting the file-naming preference

The file-naming preference in Lightroom’s External Editing preferences determines 
the names of derivative files generated during a Lightroom–Photoshop workflow. 

By default, derivative files will have the original filename followed by -Edit and then 
the suffix of the file format set in the primary external editor preferences. This section 
explains how to customize derivative filenames using the Filename Template Editor. 

This is the same Filename Template Editor used to rename files in the Import win-
dow, the Export window, and elsewhere in Lightroom. If you covered the Filename 
Template Editor earlier in this lesson in “Importing from a camera,” students 
already know how to use it.

Configuring Photoshop’s Color Settings dialog
The next two sections take place in Photoshop, rather than Lightroom. This section 
suggests setting Photoshop’s RGB working color space to ProPhoto RGB to match 
Lightroom’s native ProPhoto RGB color space so that colors in an image appear 
consistent in Lightroom and Photoshop on a student’s workstation.

Configuring Photoshop’s Maximize Compatibility preference
This section explains how to enable Photoshop’s Maximize Compatibility prefer-
ence to ensure that Lightroom can read layered Photoshop files.

Keeping Lightroom and Camera Raw in Sync
To avoid the appearance on students’ workstations of mismatch warnings (like the 
one shown in the “Encountering a Lightroom-Camera Raw mismatch” sidebar in 
Lesson 2,) keep Lightroom, Photoshop, and Camera Raw up to date on all class-
room workstations.
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Lesson 2:  
Lightroom–Photoshop Roundtrip Workflow
This is the most critical lesson in the course. Use it to walk students through the 
steps of a complete Lightroom–Photoshop roundtrip workflow. The steps covered 
in this workflow are:

•	 Making initial, nondestructive adjustments to a raw file in Lightroom

•	 Rendering the raw file to an RGB file by passing it from Lightroom to Photoshop

•	 Making layered edits in Photoshop (adding type and removing content)

•	 Saving the RGB derivative file (a TIFF) from Photoshop 

•	 Adding more adjustments to the TIFF in Lightroom (converting to black 
and white)

•	 Taking the TIFF back to Photoshop for another round of editing (re-editing the 
type layer)

•	 Exporting a copy of the file from Lightroom with all the Lightroom and 
Photoshop edits

Related topics covered in this lesson include:

•	 Using each of the three options for passing an RGB file from Lightroom to 
Photoshop (Edit Original, Edit a Copy with Lightroom Adjustments, and Edit 
a Copy) 

•	 The differences involved in starting a Lightroom–Photoshop workflow with 
a JPEG

Preparing for this lesson

This section, which is found at the beginning of each of Lessons 2 through 8, 
reminds students to take the preparatory steps introduced in the “Getting Started” 
lesson if they haven’t already done so: setting up a student name LPCIB folder to 
house the student’s lesson files and Lightroom catalog, downloading the lesson files 
to the LPCIB folder, and opening the LPCIB catalog. 

It is recommended that students import the lesson files into the LPCIB catalog on 
a lesson-by-lesson basis. Step 4 consists of step-by-step instructions for importing 
the Lesson 2 files into the LPCIB catalog. For more detail on any of these import 
steps, refer to Lesson 1, “Importing from a drive,” which covers using the same 
import method to import any photographs from a drive into Lightroom. 
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Taking a raw file from Lightroom to Photoshop

Before walking students through the roundtrip Lightroom–Photoshop workflow 
detailed in this lesson, summarize the workflow.

The workflow starts in Lightroom because that’s where the hook between 
Lightroom and Photoshop—the Edit In menu—is located. It makes sense to start 
in Lightroom for a number of other reasons: The comprehensive photo manage-
ment system in Lightroom’s Library module (described in Lesson 3) is home base 
for many photographers, and developing photographs in the same application 
in which they are managed is convenient and seamless. The adjustments made 
in Lightroom are nondestructive of the original image; they are just text-based 
instructions stored in the Lightroom catalog. And frankly, adjusting photographs 
using Lightroom’s intuitive Develop module controls is easier for many users than 
editing in Photoshop.

However, sometimes Lightroom’s capabilities aren’t enough. Compositing with 
layers, stitching panoramas, blending HDR images, complex masking, advanced 
retouching, and the other enhancements addressed in the book are tasks for 
Photoshop. And that’s where the roundtrip workflow comes in. 

The roundtrip workflow in a nutshell is this: Apply initial, nondestructive adjust-
ments to source images in Lightroom, pass those photographs from Lightroom 
to Photoshop for pixel-based editing, and save derivative images from Photoshop 
that can be managed back in Lightroom along with the source images. Additional 
round-tripping between Lightroom and Photoshop to add more edits in both pro-
grams is also an option.

Students may ask you about Camera Raw and how it compares to Lightroom. The 
Camera Raw plug-in for Photoshop offers nearly the same features as Lightroom’s 
Develop module. Camera Raw and Lightroom are both raw converters, they use 
same raw conversion engine, and Camera Raw is often responsible for render-
ing photographs behind the scenes from Lightroom to Photoshop as explained in 
this lesson. So a common question is why you would use Lightroom rather than 
Camera Raw to process photographs. One reason is that Lightroom is built on 
a database; Camera Raw is not. Lightroom’s database structure supports many 
powerful features in Lightroom that Camera Raw does not have (offline browsing, 
Smart Previews, virtual copies, and perpetual history, to name just a few). A related 
reason is that Lightroom includes a sophisticated photo manager—the Library 
module. Although Camera Raw can be used with Adobe Bridge, Bridge is a just file 
browser, not a database with the sophisticated photo management features found 
in Lightroom. 
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Making initial adjustments in Lightroom
Have students make some Basic panel adjustments to the Lesson 2 DSCF0431.dng 
file, a raw photograph of clouds behind a mountain. The specific adjustments are 
not of consequence for this exercise. The idea is just to make some adjustments in 
Lightroom before passing this file to Photoshop. Choosing Basic panel settings is 
covered in detail later in Lesson 4, “Adjusting color and tone in the Basic panel.” 
If your students want guidance with Basic panel adjustments for this image now, 
suggest increasing Contrast slightly, decreasing Highlights significantly to recover 
detail in the clouds, increasing Shadows to recover detail in the dark trees, increas-
ing Whites to set a white point, decreasing Blacks to set a black point, increasing 
Clarity for midtone contrast, and increasing Vibrance slightly for color saturation. 

In this section and throughout the course, do not require students to use the same 
adjustment values that are displayed in the illustrations in the book or that you use 
in classroom demonstrations, because each monitor may be calibrated differently. 
Allowing students to choose settings themselves also encourages creativity, self-
expression, and experimentation.

Students will continue working with this same image throughout much of this les-
son, so they should leave it open at the end of each section and continue using it in 
the next section unless the instructions indicate otherwise.

Rendering a raw file into Photoshop
In this section, students use Lightroom’s default Edit In command to hand off to 
Photoshop the raw source file with its initial Lightroom adjustments, in order to 
add text and remove content in Photoshop.

Lightroom’s default Edit In command is Edit In Adobe Photoshop CC (or the latest 
version of Photoshop installed on the student’s workstation). That command is 
the first option in Lightroom’s Edit In menu. The Edit In menu is accessible from 
a number of places—the Photo menu in the menu bar at the top of the Library, 
Develop, and Map modules, and the contextual menus that pop up when you right-
click/Ctrl-click an image in many of Lightroom’s modules. The keyboard shortcut 
for the default Edit In command is Ctrl-E/Command-E.

Explain that passing a raw file from Lightroom to Photoshop appears to be seam-
less, but behind the scenes the Camera Raw plug-in is working to render the raw 
file to pixels so that it can be viewed and edited in Photoshop. If you were to open 
a raw file from outside of Lightroom (for example, from Adobe Bridge), the Camera 
Raw window would appear. However, when a raw file is passed from Lightroom to 
Photoshop using the default Edit In command, the Camera Raw window does not 
appear. Instead, Camera Raw goes to work behind the scenes to render the raw file 
and open it directly into Photoshop. 
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The image opens in Photoshop with the initial Lightroom adjustments that stu-
dents made in the last section of this lesson. The color space, bit depth, and resolu-
tion of the image in Photoshop are those that students set in Lightroom’s prefer-
ences in Lesson 1. The filename at the top of Photoshop’s document window still 
displays a raw suffix (.dng), because the rendered image exists only in memory until 
it is saved in Photoshop.

Encountering a Lightroom-Camera Raw mismatch

If the versions of Lightroom and Camera Raw on a classroom workstation don’t 
match, when a student uses the Edit In command to pass an image from Lightroom 
to Photoshop a warning like this may appear: “This version of Lightroom may 
require the Photoshop Camera Raw plug-in version [xx].” 

Consult the sidebar “Encountering a Lightroom-Camera mismatch,” located later in 
Lesson 2, for information about which option to choose in this warning. To avoid 
this warning in the future, keep the classroom workstations continuously updated 
with the latest versions of Lightroom, Photoshop, and Camera Raw. 

Editing in Photoshop
In this section, students make two edits to the rendered image in Photoshop— 
adding text (ASPEN) and removing content (the jet trail in the sky). These edits add 
a type layer and a pixel layer in the Layers panel. Although Lightroom has some 
features with which you could attempt these edits (the Identity Plate in Lightroom’s 
Print module for adding small amounts of text, and the Spot Healing Brush tool 
in Lightroom’s Develop module for removing content), Photoshop has more full-
featured tools and options for accomplishing both.

If students are Photoshop beginners, you may want to precede this section with 
an introduction to Photoshop. Adobe Photoshop CC Classroom in a Book is a 
useful resource.

Saving an RGB file from Photoshop to Lightroom

In this section, students save the image they edited in Photoshop in the last section. 
Saving that image using Photoshop’s Save command generates a derivative copy 
that is automatically included in the Lightroom catalog. 

Emphasize the importance of using Photoshop’s Save command rather than the 
Save As command to ensure that Lightroom recognizes the derivative file as related 
to the source file and includes it in the Lightroom catalog automatically. 

The source file in this exercise happens to be a raw file. The derivative file saved from 
Photoshop is an RGB file, which is always the case in a Lightroom–Photoshop work-
flow. The format of this derivative file is TIFF, because that’s the file format option 
that students set in Lightroom’s primary external editor preferences in Lesson 1. 
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Point out the differences between the two related files that are now visible in the 
Lightroom catalog: 

•	 The raw source file displays the initial Lightroom adjustments (Basic panel 
adjustments). These adjustments remain editable in Lightroom. 

•	 The derivative TIFF file displays both the initial Lightroom adjustments and 
the layered Photoshop edits (the text ASPEN and the absence of a jet trail). The 
Lightroom adjustments in the TIFF are baked in and no longer editable, but the 
Photoshop layers in the TIFF can be accessed and re-edited in Photoshop using 
Lightroom’s Edit Original command, as students will do shortly.

Making more adjustments in Lightroom
If you plan ahead, a single roundtrip from Lightroom to Photoshop and back to 
Lightroom may be sufficient to accomplish all edits. However, the derivative file can 
be fine-tuned with additional rounds of editing in Lightroom and/or Photoshop, as 
the next few sections demonstrate. In this section, students add another Lightroom 
adjustment (a black and white conversion) to the derivative TIFF file in addition to 
the previous Lightroom and Photoshop edits. 

Taking an RGB file back to Photoshop 
for further editing

This section introduces a new concept: passing an RGB file—a TIFF, PSD, or 
JPEG—from Lightroom to Photoshop. This workflow is not as seamless as hand-
ing off a raw file. With an RGB file, after you invoke the Edit In > Edit in Adobe 
Photoshop [xx] command, there are three editing options to choose from: Edit 
Original, Edit a Copy with Lightroom Adjustments, or Edit a Copy. (Depending 
on which version of Photoshop CC you have installed, this command might read 
Adobe Photoshop CC or Adobe Photoshop CC 2014. Photoshop [xx] is used 
throughout this guide to stand for versions of the command.)

Students should understand what each of these options does and when each option 
is most useful.

Edit Original option
Explain that Edit Original is the option to choose when you have a TIFF or PSD file 
in Lightroom that contains layers that you want to edit in Photoshop. This means 
that if you add layers in Photoshop during a Lightroom–Photoshop workflow, you’ll 
be able to access those layers again in Photoshop for re-editing (although the Edit 
Original option works the same way even if you’re starting with a file that acquired 
its layers outside of a Lightroom–Photoshop workflow).
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In this section, students continue to work with the derivative TIFF from the pre-
ceding sections (the black and white version of the photograph of clouds behind a 
mountain). This image was already passed from Lightroom to Photoshop earlier in 
the lesson, when it acquired its ASPEN type layer. In this exercise, students pass the 
derivative TIFF from Lightroom back to Photoshop to edit that type layer. 

This TIFF file was converted to black and white in Lightroom in the last section, 
and it appears black and white in Lightroom. Students may be surprised that when 
they pass the file from Lightroom to Photoshop using the Edit Original option, the 
image appears in color in Photoshop rather than in black and white. This is due to 
the Edit Original option, which displays an RGB file as it was before the last adjust-
ment in Lightroom. Reassure students that the black and white Lightroom adjust-
ment is not gone forever. After editing the TIFF in Photoshop (changing the type 
layer ASPEN to Colorado) and saving it again, back in Lightroom the TIFF displays 
the black and white Lightroom adjustment, as well as the change to the text made 
in Photoshop.

Later in this lesson, in “Completing the workflow in Lightroom,” students will work 
with this TIFF again. So tell students to be sure to keep this TIFF, with all its adjust-
ments, in their Lightroom catalog. In the meantime, they’ll use other lesson files to 
explore the other RGB options.

Edit a Copy with Lightroom Adjustments option
Explain that Edit a Copy with Lightroom Adjustments is the most useful option 
when you’ve made several rounds of Lightroom–Photoshop edits and you want 
a comprehensive RGB file that displays all your Lightroom and Photoshop 
adjustments. 

This section starts with a different Lesson 2 file, P1100132.psd, a color photograph 
of spring tulips. This source file is an RGB image—a layered PSD with several 
Photoshop adjustment layers. 

The exercise instructs students to convert this image to black and white in 
Lightroom and then to pass it to Photoshop using the Edit a Copy with Lightroom 
Adjustments option. This opens a copy of the image in Photoshop. 

The Edit a Copy with Lightroom Adjustments option has the following effects 
on the copy that’s open in Photoshop: The adjustment made in Lightroom (the 
black and white conversion) has been embedded and is visible in this copy. The 
Photoshop adjustment layers that were in the PSD source file have been applied 
to the copy and flattened (so they are no longer editable).

The exercise instructs students to add a new layer to the copy that’s open in 
Photoshop (a type layer with the text Spring) and save the file. The resulting 
RGB derivative file is a TIFF (in accordance with Lightroom’s External Editing 
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preferences). The TIFF is automatically included in the Lightroom catalog, where 
there are now two related files:

•	 The source PSD image displays the Lightroom adjustment (the black and white 
conversion) and retains the original, editable Photoshop adjustment layers 
(which could be edited in Photoshop using the Edit Original option). 

•	 The derivative TIFF image displays all the Lightroom and Photoshop 
adjustments. However, the only adjustment that remains editable is the newly 
added Spring type layer (which could be edited in Photoshop using the Edit 
Original option). The other adjustments have been baked into the derivative file.

The following is supplemental to the instructions in the book: If you want to dem-
onstrate that the Lightroom adjustment (the black and white conversion) remains 
editable in the source file, have students open the PSD source file in Lightroom’s 
Develop module and click the Reset button to change the PSD from black and 
white back to color. Ctrl-Z/Command-Z will undo that change. To demonstrate 
that the Lightroom adjustment (the black and white conversion) is not editable in 
the derivative file, have students open the derivative TIFF in the Develop module 
and click the Reset button. The TIFF does not change back to color; it remains 
black and white.

Edit a Copy option
Explain that Edit a Copy can be a useful option when you have a layered RGB 
image, you’ve added adjustments in Lightroom, and you want another copy that 
retains the layers but not the Lightroom adjustments.

This section starts with another Lesson 2 file, P1090025.psd, a color photograph 
of thistles. This source file is an RGB image—a layered PSD with a hue-saturation 
adjustment layer. 

The exercise instructs students to convert this image to black and white in 
Lightroom and then to pass it to Photoshop using the Edit a Copy option. This 
opens an RGB copy of the image in Photoshop. 

The Edit a Copy with Lightroom Adjustments option has the following effects: 
The adjustment made in Lightroom (the black and white conversion) is not visible 
in Photoshop. The layers that were in the original source file are visible and acces-
sible for editing in Photoshop. A black and white copy of the source image in PSD 
format automatically appears in Lightroom although the image has not yet been 
saved from Photoshop.

The exercise instructs students to add a new layer in Photoshop (a type layer with 
the text Thistle) and save the file. This updates the PSD copy in Lightroom, which 
now displays the Thistle text but not the black and white Lightroom conversion. 
There are now two related files in Lightroom:
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•	 The source PSD displays the Lightroom adjustment (the black and white 
conversion), which remains editable in Lightroom, but it does not display 
the new Thistle type layer.

•	 The derivative file (the PSD copy) displays the new Thistle type layer. (The layers 
could be edited in Photoshop by using the Edit Original command.) But this 
derivative file does not display the Lightroom adjustment (the conversion to 
black and white); it is a color image like the original.

Starting with a JPEG
The Lightroom–Photoshop workflow is different if you start with a JPEG in 
Lightroom, pass the JPEG from Lightroom to Photoshop, and add layers in 
Photoshop. When the file is saved from Photoshop, Lightroom does not recognize 
it as a derivative of the original and does not automatically include it in the catalog. 

This section starts with another Lesson 2 file, DSCF3037.jpg, a color photograph 
of snail shells in JPEG format.

The exercise instructs students to add a sepia-toned preset to the JPEG in 
Lightroom, and then to pass it to Photoshop using the Edit Original option (which 
causes the Lightroom sepia toning not to appear in Photoshop). Students then add 
a new layer in Photoshop (a type layer with the text PROVENCE) and choose File > 
Save. This does not automatically save the file and include it in the Lightroom cata-
log. Instead the Save As dialog opens. Students are instructed to manually choose 
TIFF as the file format in the Save As dialog to keep the layers intact.

There is now only one version of the image in the Lightroom catalog—the JPEG 
with the sepia tone preset that was added in Lightroom. The TIFF that was saved 
from Photoshop is not present in Lightroom. Students are instructed to use the 
Synchronize Folder command to manually import the TIFF version of the image 
into the Lightroom catalog. The following files are now visible in Lightroom:

•	 The original JPEG displays only the Lightroom adjustment (the sepia toning), 
which remains editable in Lightroom.

•	 The TIFF version of the image displays only the PROVENCE text added in 
Photoshop—not the sepia toning added in Lightroom. In essence, Lightroom 
is treating the TIFF as a separate image from the original JPEG.

Completing the workflow in Lightroom

In this section, students complete the Lightroom–Photoshop workflow, fine-tuning 
an image in Lightroom and then exporting a copy of the final image with all its 
Lightroom and Photoshop edits.
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This section starts with the TIFF version of the photograph of clouds behind a 
mountain as it was at the end of the “Edit original option” section earlier in this les-
son. This file should be in the students’ Lightroom catalog as DSCF0431-Edit-P.tif. 
This version of the image is not in the original lesson files; it was generated during 
this lesson as a derivative of the Lesson 2 DSCF0431.dng file. You’ll find a summary 
of all the adjustments that were made to this file so far in this section.

Tweaking the RGB file again in Lightroom 
This section instructs students to make a few final adjustments to the final image, 
DSCF0431-Edit-P.tif, in Lightroom (adjusting the Lightroom black and white con-
version applied earlier in this lesson, and adding a vignette).

Counsel students to think of the resulting image in Lightroom as the master file. 
It contains all the adjustments added in both Lightroom and Photoshop through 
a series of roundtrip edits. It hasn’t been reduced in size, compressed, or otherwise 
compromised. This is the file to return to whenever someone needs a copy of the 
final image for a particular purpose.

Exporting from Lightroom
Photoshop users are accustomed to outputting images by saving and often end 
up saving multiple versions of an image in different formats and sizes for differ-
ent purposes. There is no save command in Lightroom. Instead, students can use 
Lightroom’s Export dialog to efficiently generate a copy of an adjusted image at 
any time with whatever output parameters are needed at the moment. 

This section walks students through the process of exporting a copy of the 
“master file” they generated during the Lightroom–Photoshop workflow in this 
lesson, DSCF0431-Edit-P.tif. They’ll set all the parameters they need to export 
a copy of the file to post online, including file format, size, color space, filename, 
sharpening, and more.

You can supplement this section by discussing how to set these parameters for 
other use cases, like printing a large print on matte paper, or printing small cards 
on glossy paper.

If students have access to a printer, you could have students print a copy of the 
completed lesson file one of two ways:

•	 Export a copy of the file with the proper export parameters for print. Open the 
exported file into Photoshop, and print from there.

•	 Print the image directly from Lightroom’s Print module. For information about 
the Print module see Adobe Lightroom 5 Classroom in a Book.
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Lesson 3:  
Managing Photos in Lightroom’s Library Module
Lightroom’s Library module is a powerful photo manager. It offers multiple ways 
to view, organize, rank, find, and share photographs, including iterations produced 
during a Lightroom–Photoshop workflow. This lesson introduces the Library mod-
ule and demonstrates how and when to use its major features.

Preparing for this lesson

This section instructs students to import the Lesson 3 files to the LPCIB catalog. It 
is the same as the section of the same name in Lesson 2 and subsequent lessons.

The Library module workspace

This section describes the Library module layout and features, navigation basics 
(zooming, panning, selecting, and viewing photos), and ways to customize the 
Library module workspace. 

This material lends itself to lecture-style teaching, interspersed with a few exercises. 

There is a lot of information in the subsections of “The Library module workspace” 
section. The teaching points to emphasize follow.

The Folders panel
•	 Selecting a folder displays all the photographs in that folder and its subfolders.

•	 The number to the right of a folder reveals the number of photographs in that 
folder and its subfolders.

•	 The Folders panel does not display all the folders on a drive for the sake of 
brevity. To display a folder one level up from a visible folder, right-click/Ctrl-
click the visible folder and choose Show Parent Folder. You can repeat this up 
the folder hierarchy. To hide a parent folder, right-click/Ctrl-click it, and choose 
Hide This Parent.

The Histogram panel
•	 The histogram represents the tonal values in a selected photograph from dark 

tones on the left to bright tones on the right.

•	 There is useful information under the histogram about the camera settings used 
to shoot a selected photograph.
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•	 This histogram in the Library module is useful when you’re reviewing images 
after a shoot. There is also a live histogram in the Develop module to consult 
while you’re adjusting a photograph.

•	 Click on various thumbnails in the Library module grid so students can see the 
histogram for different images.

The Quick Develop panel
•	 Quick Develop panel adjustments are relative rather than absolute. 

•	 The Quick Develop panel is useful for applying presets. Presets can also be 
applied from the Preset panel in the Develop module.

•	 Most adjustments are done in the Develop module rather than the Quick 
Develop panel.

The Keyword panels
•	 There are two keyword panels. The Keywording panel is for creating and 

applying keywords. The Keyword List panel displays a list of all keywords.

•	 Keywording is covered in more detail later in this lesson.

The Metadata panel
•	 The Metadata panel displays information about a selected photograph, some of 

which comes from the camera and some of which is created in Lightroom.

•	 A quick way to change the name of a single selected photograph is to type a new 
name in the Metadata panel’s File Name field.

•	 You can add copyright information to photographs using the copyright fields or 
the Preset drop-down menu in the Metadata panel.

The toolbar
•	 The keyboard shortcut T hides and shows the toolbar. If you don’t see the 

toolbar at the bottom of the Library module, press T to bring it into view.

•	 Useful default tools on the Library module toolbar include buttons for switching 
image views (Grid view, Loupe view, Compare view, and Survey view), the 
Sort menu for reordering thumbnails in the grid, and the Thumbnails slider 
for sizing thumbnails in the grid.

•	 The keyboard shortcut for Grid view is G; the keyboard shortcut for Loupe view 
is E (not L as you might guess). These shortcuts are used often.

•	 The toolbar can be customized by clicking the arrow on its right side and 
choosing other tools.
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The Filmstrip
•	 The Filmstrip displays thumbnails of all photographs in the source selected in 

the Catalog, Folders, or Collections panel.

•	 The Filmstrip is most useful when working in Loupe view, Compare view, or 
Survey view.

•	 Hide the Filmstrip when you need more room to view images. To hide or show 
the Filmstrip, click the black border below the Filmstrip.

•	 The bar at the top of the Filmstrip has useful information, including Go Back 
and Go Forward buttons and the path to the selected photograph.

The Module Picker
•	 Click a module name in the Module Picker to switch to that module, or use 

keyboard shortcuts like D for the Develop module and G for the Library module.

•	 The Module Picker bar includes a customizable Identity Plate in which a 
photographer can display his or her identity by entering text or inserting a 
premade graphic.

•	 Hide the Module Picker bar when you need more room to view images. To hide 
and show the bar, click the black border above it.

Zooming and panning
•	 The zooming and panning options in the Library module are similar to those for 

the Develop module covered later in these notes.

Selecting
•	 When you select multiple thumbnails, one will be most selected, which means 

that it will be the source of settings if you synchronize settings among the 
selected images. Synchronizing is covered in the exercise in this section.

•	 Get in the habit of selecting the thumbnail frame rather than the thumbnail 
image for the reason described in the sidebar “Selecting the thumbnail frame.” 
But do select the thumbnail image to drag an image into a folder or collection in 
the Library module.

Customizing the Library module
The Library module offers several ways to view photographs. Advise students to 
memorize the keyboard shortcuts for Grid view (G) and Loupe view (E), because 
they’ll switch between those views often as they review their photographs in the 
Library module.
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•	 Grid view (G) displays small thumbnails of many photographs arranged in a grid 
pattern. To allocate more room to the grid, press Tab to collapse the left and right 
columns, or press Shift-Tab to collapse all the bars and columns. To collapse a 
single bar or column, click the thin black border outside that bar or column.

•	 Loupe view (E) offers a large view of a single photograph that’s useful for 
evaluating the image. Enhance that view further by isolating the image against a 
darkened background. Press L several times to cycle between Lights Off, Lights 
Dim, and Lights On views.

•	 You can also cycle among screen views by pressing Shift-F. 

Ranking Photographs

Evaluating and ranking photographs is an important photo management task. 
The exercises in this section and its subsections suggest some practical ways to 
employ flags, star rankings, and color labels, and to find photographs by filtering 
on those attributes.

Emphasize that you do not have to use all these organizational tools. 

Suggest using different tools for different purposes to avoid confusing redundancy. 
For example, students might use flags to indicate picks and rejects and use color 
labels to indicate photos in a series of panorama or HDR shots. 

Urge students to use the tools in a way that makes sense to them. For example, 
if they decide to use star rankings, they don’t have to apply all five of the star 
categories; it may be more meaningful to use just three-star categories to rank 
photographs.

Organizing with collections

This section and its subsections demonstrate the power of collections and smart 
collections to keep track of related photographs without moving them out of 
their folders.

Teach how to create collections manually first. Suggest using collections in unique 
ways that are not redundant with folders. For example, rather than using collec-
tions as subject matter albums, students could use them to keep track of photo-
graphs for use in projects, like a book or website. 

Make sure students understand that a photograph can appear in more than one 
collection and that removing a photograph from a collection does not delete the 
photograph from the catalog or drive.
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Move on to the more sophisticated concept of smart collections. An analogy you may 
find useful for explaining a smart collection is that it is like a saved search that auto-
matically updates to include each new photograph that meets the search criteria. 

The exercise in the section “Building smart collections” uses just a few simple 
search criteria and rules. You can expand on this lesson by having students create 
more complex smart collections using different criteria and more rules.

Keywording

Keywording is a powerful way to categorize and find photographs by subject mat-
ter. This section and its subsections show how to create keywords, apply keywords 
to photographs, and use keywords to find photographs. 

In addition to using the exercises to demonstrate the mechanics of keywording, 
supplement the lesson with tips for creating a successful keyword system. 
Emphasize that the purpose of creating keywords is to build a list of terms that will 
help a photographer find one or more photographs among many. The key to doing 
that is to be consistent about keywording. A good time to keyword is right after 
importing new photographs from a shoot, so the task doesn’t become so large that 
it overwhelms. And advise students to customize their keyword lists to contain 
terms they personally would use when searching for a particular photograph.

Moving files and folders

It’s common for novice Lightroom users to end up with question marks on fold-
ers and exclamation marks on files in the Library module, indicating that files and 
folders are missing from the catalog. This section and its subsections clarify what 
causes those problems, how to avoid them, and how to fix them if they do occur.

The main point is that files that have been imported into a Lightroom catalog 
should not be moved between folders outside of Lightroom. Doing so breaks the 
link between the images and the Lightroom catalog, so that from Lightroom’s point 
of view the files and sometimes the folders are missing. (This problem can also 
occur if files or folders are renamed outside of Lightroom.)

The section “Moving files inside the Library module” demonstrates how to avoid 
the problem. The section “Re-linking missing files” shows how to remedy the prob-
lem. And the sidebar “Moving a folder and files outside Lightroom” suggests an 
alternative method for moving large numbers of files to a new location.

Don’t let the warning against moving Lightroom photographs scare you away 
from viewing student work on another computer or allowing students to take their 
work home. That is possible if you follow the instructions at the beginning of these 
Instructor Notes in the section “Managing student projects.”
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Lesson 4:  
Processing Photos in Lightroom’s  
Develop Module
The Develop module is where students will spend much of their time in Lightroom 
throughout this course and outside the classroom. So it’s important that they 
understand the layout of the Develop module and how to use its major features—
which are the focus of this lesson. 

Preparing for this lesson

This section instructs students to import the Lesson 4 files to the LPCIB catalog. 
It is the same as the section of the same name in Lesson 2 and subsequent lessons.

How Lightroom’s editor works

Introduce this lesson by explaining the parametric editing system that underlies 
Lightroom’s Develop module. Use the information in this section to describe how 
it works, how it differs from pixel editing in Photoshop, and the benefits it offers 
(nondestructive editing and flexible editing features). 

Photo editing workflow

Advise students to take the time to plan a Lightroom–Photoshop workflow in 
advance so that most fundamental adjustments to photo quality (correcting basic 
tone and color, removing spots, reducing noise, performing initial sharpening, 
fixing lens-related issues, and in some cases making local adjustments) are done 
in Lightroom first before passing files to Photoshop for specific enhancements. 

The advantage of this workflow, if the original is a raw file, is that fundamental 
adjustments are applied while the file is still in its raw state and has maximum 
editing latitude. Another advantage, whether or not the original is a raw file, is 
the relative ease with which standard editing tasks can be accomplished using 
the intuitive controls in Lightroom’s Develop module.

The Develop module workspace

This section and its subsections introduce the Develop module interface and offer 
tips for working in the Develop module, including customizing the Develop mod-
ule workspace, zooming and panning in the Develop module, undoing adjustments, 
and comparing before and after views of adjustments.
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Interface overview
Take your students on a quick tour of the layout and major features in the 
Develop module, which are summarized in this section. The first illustration in 
the “The Develop module workspace” section is a reference map for the Develop 
module features mentioned in the text. 

Customizing the Develop module
This section suggests some ways to customize the Develop module, including 
collapsing bars and panel columns for more working space, and setting the 
panels in the right column to Solo Mode (which is particularly useful on a small 
laptop screen). 

The sidebar in this section is a useful collection of shortcuts for customizing the 
Develop module.

Zooming and panning
This exercise shows how to toggle between zoom levels and pan around a zoomed-
in image in the center work area. Some points to mention in class are:

•	 The default zoom levels are Fit (which zooms out until the entire image is visible 
in the work area) and 1:1 (which displays one image pixel in one screen pixel). 

•	 The 1:1 zoom level is the best for evaluating noise, sharpness, and focus.

•	 Simply click the image in the work area to toggle between the default 
zoom levels.

•	 There is a menu of specific zoom levels at the top of the Navigator panel. 
Changing that option (for example, choosing 4:1) changes the default zoom 
levels (which would then toggle between Fit and 4:1). To reset to the original 
default zoom levels, click 1:1 at the top of the Navigator panel.

Undoing adjustments
The Develop module offers multiple ways to undo and redo adjustments. Methods 
covered in this section include:

•	 The undo and redo commands (and their keyboard shortcuts) for rolling 
backward and forward one step at a time

•	 The Reset button, which removes all Develop adjustments

•	 Creating and activating a snapshot of all adjustments to access a particular state 
of adjustments

•	 Accessing a history state in the chronological History panel, which remains 
available even after closing and opening Lightroom (unlike the History panel 
in Photoshop)

E	Tip:  By default, the 
panel columns are set 
to collapse and expand 
automatically (Auto 
Hide & Show) when 
you hover over the 
border outside each 
column. Students may 
find it more useful to 
control that behavior 
manually. To set that 
up, right-click/Ctrl-click 
the border outside each 
column and choose 
Manual. Then click that 
border to manually 
collapse or expand 
the column. The same 
option is available for 
the top and bottom 
bars as well.
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Developing photographs

This section is critical to understanding the essential adjustment tools in the 
Develop module. The subsections are presented in the optimal order for ease of use 
and performance, although the results don’t depend directly on the order of opera-
tions since all Develop module adjustments are just instructions (see “Order of 
adjustments” in this lesson). The Develop module workflow used in this section is:

1	 Make fundamental global adjustments (adjustments that affect the entire image) 
to tone and color in the Basic panel. 

2	 Make additional global adjustments, if needed, in the Tone Curve panel and 
HSL panel. 

3	 Perform global noise reduction and capture sharpening in the Detail panel. 

4	 Clean up dust spots using the Spot Removal tool. 

5	 Perform Lens Corrections, if needed. Do this after spot removal to maximize 
performance. 

6	 Apply local adjustments (adjustments that affect part of the image) using the 
Graduated Filter tool, Adjustment Brush tool, and/or Radial Filter tool.

7	 Optionally, save metadata to the file, which stores adjustments in the image so 
that other programs can read them. 

The image is ready to pass off to Photoshop if needed. 

The lesson files for this section are raw files (although Develop module controls 
can be used to adjust PSDs, TIFFs, JPEGs, and PNGs too). Explain that the initial 
appearance of a raw file is just Lightroom’s default conversion from raw data to 
visible image; the Develop module controls give users the ability to fine-tune the 
initial conversion.

Remind students not to worry about using the exact adjustment values in the 
illustrations, but rather to use adjustment values that look best on the image on 
their monitors.

Adjusting color and tone in the Basic panel
The Basic panel contains the most essential Develop module controls, so it should 
be covered thoroughly. Have students work through all the exercises to get practice 
applying the Basic panel controls.

Working with the sliders

Draw students’ attention to the efficiency tips in this section for using the sliders in 
the Basic panel and throughout the Develop module:

•	 To change the value of a slider, either drag it or use the methods in this section 
to increase or decrease its value in more controlled increments.
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•	 To return a slider to its default value, double-click the slider control or label.

•	 To compare a Before and After view of just one slider, perform the preceding 
tip; then press Ctrl-Z/Command-Z to return the slider to its last adjusted value.

•	 To compare a Before and After view of all sliders in the Basic panel, use the 
History panel. There is no toggle switch in the Basic panel, as in other Develop 
module panels.

•	 To compare a Before and After view of all adjustments made anywhere in the 
Develop module, toggle the Backslash key [\] on the keyboard or use the Before 
and After views, as described earlier in this lesson in “Comparing Before and 
After views.”

•	 To return all sliders in one of the sections of the Basic panel (WB, Tone, or 
Presence) to their default values, double-click the name of that section.

•	 To understand which part of the histogram is primarily affected by a slider, 
hover over that slider to invoke a gray overlay on that part of the histogram. 

White balancing

Introduce each of the three white balance controls—the Temp and Tint sliders, the 
drop-down menu of white balance presets, and the White Balance Selector tool 
(the eyedropper icon), which can be used individually or in combination. 

Point out that although the official purpose of the white balance controls is to neu-
tralize unwanted color casts, they also can be used to convey mood through color.

Explain that with a raw file, there is complete latitude to adjust white balance in the 
Develop module from scratch. However, that is not the case with an RGB image, 
like a JPEG. Hence, the values on the Temperature and Tint sliders and the number 
of options in the white balance preset menu are different for RGB images than for 
raw files.

Adjusting exposure and contrast

Describe the difference between exposure (which affects the overall bright-
ness of a photograph) and contrast (which affects the overall range of tones in 
a photograph).

Adjusting highlights and shadows

The Highlights and Shadows sliders are useful for bringing out detail in light areas 
(like clouds) and dark areas (like the foreground in a landscape), respectively. Have 
students hover over both the Highlights and Shadows sliders to see which tones in 
the Histogram panel each of these sliders primarily affects. 

Mention that the Highlights slider does a great job of recovering detail in what 
may appear to be blown-out highlight areas (bright areas with no detail). This is 
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particularly true when working with raw files. However, you need to capture some 
highlight detail to bring it back with the Highlights slider.

Mention that increasing the Shadows slider is useful for revealing detail in shadow 
areas but that it can leave a photograph looking washed out or flat. Decreasing the 
Blacks slider can compensate for that.

Setting white and black points

The Whites and Blacks sliders are useful for boosting contrast by setting the 
brightest areas of a photograph to bright white and the darkest areas to rich black, 
respectively. Have students hover over both the Whites and Blacks sliders to see 
which tones in the Histogram panel each of these sliders primarily affects.

Remind students to use the Highlight Clipping warning, as demonstrated in this 
section, to avoid losing too much detail in the highlights. The Shadow Clipping 
warning is less crucial but can also be useful.

Adding positive or negative clarity

In this section, students use the Basic panel’s Clarity slider in the positive direc-
tion to add punch to a photograph. Positive clarity increases midtone contrast and 
adds edge definition. Warn students not to increase Clarity too much if they want a 
photograph to have a natural look.

Remind students that the Clarity slider offers another effect—the soft, diffuse glow 
of negative clarity—that often looks good on a portrait.

Controlling color saturation

Both the Vibrance and Saturation sliders in the Basic panel can be used to make 
color more or less intense. 

Explain the difference between the two sliders. Increasing the Saturation slider 
intensifies all colors to the same degree, whereas increasing the Vibrance slider has 
a stronger effect on desaturated colors and protects colors common in skin tones 
from oversaturation. Encourage students to experiment with each slider and even 
to try applying them in combination.

Fine-tuning contrast in the Tone Curve panel
Adding a tone curve on top of Basic panel adjustments is optional. Curves are a 
relatively advanced subject, but the good news for all users is that Lightroom’s Tone 
Curve panel simplifies the process of creating curves. Curves can also be applied 
in Photoshop, but it makes sense to apply a Tone Curve to a raw file in Lightroom 
before rendering the image into pixels in Photoshop.

This section introduces several ways of creating curves in the Tone Curve panel—
dragging sliders in the Parametric Tone Curve panel, working directly on the image 
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with the Targeted Adjustment tool, and creating curves in the more advanced Point 
Curve panel. For more about curves in Lightroom, see “Adjusting contrast using the 
tone curve” in Adobe Photoshop Lightroom 5 Classroom in a Book.

Fine-tuning color in the HSL panel
This section covers changing three properties of color—hue, saturation, and light-
ness—in the Develop module’s HSL panel. 

Emphasize that HSL adjustments affect a color everywhere it appears in an image. 
Adjusting color in just one part of an image is a job for the Adjustment Brush tool 
and other local adjustment tools, which are covered later in this lesson. 

Reducing noise in the Detail panel
This section covers two kinds of digital noise—color noise and luminance noise—
and teaches how to reduce both in the Develop module’s Detail panel. 

For this section, students switch temporarily from the photograph they’ve been 
using for most of this lesson to another photograph in which there is more visible 
digital noise. Digital noise is most likely to be present in dark areas of a photograph 
and in a photograph shot with a relatively high ISO.

Remind students to zoom in to 1:1 view to accurately view noise and evaluate 
its reduction. 

Capture sharpening in the Detail panel
This section covers how to perform capture sharpening using the sliders in the 
Develop module’s Detail panel. The key point is that the sharpening done in the 
Detail panel is just the first of several rounds of sharpening commonly applied to a 
photograph. The purpose of capture sharpening is to counteract the softness that is 
inherent in digital capture. Later, a photograph may also undergo creative sharpen-
ing, such as sharpening the eyes in a portrait using the Adjustment Brush tool in 
Lightroom or the Sharpen tool in Photoshop. And when the final image is ready for 
output there usually is another round of sharpening geared to the type of output—
print or screen. In the Lightroom–Photoshop roundtrip workflow in the book, final 
output sharpening takes place in Lightroom’s Export module, covered in Lesson 2, 
“Exporting from Lightroom.”

Caution students that capture sharpening in the Detail panel should not be 
overdone, because it is likely to be just one of several rounds of sharpening. Also, 
remind students to zoom in to 1:1 view to evaluate the sharpening they perform in 
the Detail panel accurately.
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Retouching with the Spot Removal tool
The Develop module’s Spot Removal tool is useful for hiding spots caused by dust on 
a lens or sensor, blemishes, and other small pieces of content that fit within a circular 
patch. Lightroom’s Spot Removal tool can also hide some noncircular content, but 
not always with as much success as Photoshop’s content-aware retouching tools.

This section shows how to use Lightroom’s Spot Removal tool to make a tiny dust 
spot visible, remove it from one photograph, and synchronize that correction to 
other photographs that are marred by the same bit of dust (see the sidebar “Syncing 
spot removal”). 

This exercise serves two teaching purposes. Not only does it demonstrate the Spot 
Removal tool but it also serves as a good example of the ease and power of batch-
processing multiple images in Lightroom.

Making lens corrections
This section covers how to fix various lens-related issues in the Lens Corrections 
panel in Lightroom’s Develop module. 

Selecting two checkboxes in the Lens Corrections panel’s Basic tab—Enable Profile 
Corrections and Remove Chromatic Aberration—is often all that’s needed to fix 
lens-related geometric distortions, vignetting, and color fringing (see the sections 
“Applying a lens profile” and “Removing chromatic aberration”).

Correcting perspective with Upright

The Upright feature in the Develop module’s Lens Correction panel is a powerful 
way to correct perspective distortions. One common example of perspective dis-
tortion is when a tall structure shot from street level appears to be leaning back. 

Instruct students to check the Enable Profile Corrections and Remove Chromatic 
Aberration check boxes in the Lens Corrections panel’s Basic tab before applying 
Upright. Then simply experiment with the four Upright options—Level, Vertical, 
Full, and Auto—to find the one best suited to a particular photograph.

Making local adjustments
Local adjustments are corrections that affect just part of a photograph. Photoshop’s 
selections and masks are particularly good at isolating corrections, so it makes 
sense to pass photographs from Lightroom to Photoshop for certain local adjust-
ments, like those covered in Lesson 6. However, some local adjustments can be 
accomplished efficiently in Lightroom’s Develop module using the tools addressed 
in detail in this section and its subsections.

The Graduated Filter tool (covered in “Working with the Graduated Filter tool”), 
the Adjustment Brush tool (covered in “Using the Adjustment Brush tool”), and 
the Radial Filter tool (covered in “Applying the Radial Filter tool”) have a lot in 
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common. So once you demonstrate one of these tools, students will be quick to 
catch on to the other two. Each of these tools can apply a cocktail of the same 
adjustments to a local area defined by a mask. The main difference between the 
tools is the shape of the mask each one builds.

The Graduated Filter tool creates a mask in the shape of a linear gradient. One 
good use for the Graduated Filter tool is to act like a graduated neutral density 
filter on a camera lens to even out the exposure between sky and foreground in 
a landscape. 

The Radial Filter tool creates an oval or circular mask. Adjustments can be applied 
outside a radial filter, which is useful for making flexible vignettes that can be 
placed off-center and to which multiple effects can be applied. Alternatively, 
effects can be applied inside a radial filter, which is useful for spotlighting pieces 
of content.

The Adjustment Brush tool allows the user to create a mask of any shape with 
brush strokes. This powerful brush can be used to sharpen, dodge, burn, color, 
enhance, and adjust almost any part of an image.

Multiple adjustments can be made with any of these tools, each represented by 
a pin that is visible when that tool is selected. Selecting a pin allows you to edit 
adjustments in the area associated with that pin.

Lightroom’s local adjustment tools lend themselves to creative experimentation and 
artistic expression. Give students time to experiment with these tools on additional 
images, either in a classroom session or an assignment.

Saving metadata to files
All changes made to a photograph in Lightroom’s Develop module or in other mod-
ules are automatically recorded in a Lightroom catalog, so there is no requirement 
to save edits made in Lightroom as there is in Photoshop. However, Lightroom 
does offer the option to save metadata to files, which will cause all changes made to 
an image in Lightroom to be stored not only in the catalog but in or with the file as 
well. This section explains why you might choose to save metadata to files and how 
to accomplish it.

Working with virtual copies
One of the practical advantages of processing photographs in Lightroom’s Develop 
module over Photoshop’s Camera Raw or Photoshop is the ability to create and 
work on virtual copies in Lightroom. This section briefly explains what a virtual 
copy is, the benefits it offers, and how to create and adjust a virtual copy. 

Cap off this lesson with a work/play session in which students make several virtual cop-
ies of a photograph and experiment with applying different looks to each virtual copy, 
making use of some of the many features and techniques they’ve learned in this lesson.
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Lesson 5:  
Lightroom to Photoshop for Combining Photos
Lessons 5 through 8 address practical scenarios in which Lightroom and Photoshop 
are often used together. These practical lessons build on foundational skills covered 
in the previous lessons.

This lesson walks students through several common scenarios in which Lightroom 
and Photoshop are used together to combine multiple photographs. Each exercise 
results in a particular type of composite (a layered design, an HDR image, or a 
panorama) and demonstrates the best way to move photos between Lightroom and 
Photoshop to make that kind of composite. You can approach each exercise in this 
lesson as a distinct subject.

Preparing for this lesson

This section instructs students to import the Lesson 5 files to the LPCIB catalog. It 
is the same as the section of the same name in Lesson 2 and subsequent lessons.

Creating a layered composite

This exercise has dual purposes:

•	 It illustrates that when you are managing images in Lightroom that you want 
to combine into a layered composite, you must pass those photographs to 
Photoshop for the compositing work. This is one of the most common scenarios 
in which Photoshop is used with Lightroom.

•	 It introduces the Open as Layers in Photoshop command in Lightroom’s 
Edit In menu.

Making initial adjustments in Lightroom
The first step in the layered composite exercise is to make adjustments in 
Lightroom to the photographs you’ll be compositing in Photoshop (referred to 
here as “component photographs”). Teaching points for this section include:

•	 Do as much adjusting as you can in Lightroom before compositing in Photoshop.

Although Lightroom and Photoshop offer photo adjustment features, it’s a 
good idea to adjust the component images in Lightroom before passing them 
to Photoshop for compositing. This takes advantage of the relative ease of use 
of Lightroom’s Develop controls, and if the component photographs are raw 
files, you’ll have more editing latitude if you adjust them in their raw state in 
Lightroom before they are rendered into pixel-based images in Photoshop.
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This section instructs students to make a few adjustments in Lightroom’s Basic 
panel. When students are working on their own photo composites, they could 
use any of the global and local adjustment features Lightroom offers on the 
component images at this stage. 

•	 As you make adjustments to component photos in Lightroom, try to achieve 
uniformity of tone, color, and texture so the photographs will look like they go 
together later in the composite.

•	 If you need to apply the same adjustments to multiple component photos, it’s 
more efficient to do that in Lightroom than in Photoshop.

When you’re working with multiple component photographs that can benefit 
from the same adjustment, it’s simpler to synchronize adjustments among 
photographs in Lightroom than to batch-process in Photoshop. 

•	 You can synchronize Develop module adjustments in Lightroom in several 
ways. One method is the manual Sync feature, described in the Lesson 4 
sidebar “Syncing spot removal.” The alternative Auto Sync feature is introduced 
in this exercise. 

Remind students that when they are finished using Auto Sync, they should 
turn it off by clicking the toggle switch to the left of the Auto Sync button. 
This avoids Auto Sync being inadvertently applied to other photographs in 
the future.

After synchronizing adjustments among photographs, you can continue to 
make adjustments to individual component photographs, as students do with 
the Adjustment Brush tool on the photograph of cupcakes in this section.

Using Lightroom’s Open as Layers in Photoshop command
The last command in Lightroom’s Edit In menu (the menu of commands for pass-
ing photographs from Lightroom to Photoshop) is Open as Layers in Photoshop. 
This command saves time when you’re passing multiple photographs from 
Lightroom to Photoshop for compositing. It opens each selected photograph into 
Photoshop as a separate layer in a single image. 

Alternatively, you could select multiple photographs in Lightroom and choose 
Edit In > Edit in Adobe Photoshop [xx]. But that would cause each photograph to 
open as a separate document in Photoshop, and you would have to take extra steps 
in Photoshop to combine them into one document. 
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Building out the layered composite in Photoshop
This section uses some basic Photoshop compositing techniques to design a layered 
composite, including converting layers to Smart Objects so you can transform them 
without risking loss of image quality, transforming multiple layers to scale down 
their contents, positioning layered images with the Move tool, and aligning layers 
with Move tool options. The point of this section is not to teach all the nuances 
of compositing in Photoshop—which is a big topic in itself—but rather to include 
some representative compositing techniques in the context of using Lightroom and 
Photoshop together.

At the end of this section, you’ll find some suggestions for other things that could 
be done to the composite layers in Photoshop, such as adding layer styles or layer 
masks. Use these ideas to spark students’ creativity if you have additional time to 
devote to Photoshop compositing.

Saving the composite back to Lightroom
The critical point in this section is to use the File > Save command, not the 
Save As command, to save the finished composite in Photoshop. Doing so 
ensures that Lightroom will automatically import the saved composite into the 
Lightroom catalog. 

When you choose File > Save, the composite is automatically saved from Photoshop 
in the format chosen in the first section of Lightroom’s External Editing prefer-
ences. In this case, the composite is saved as a TIFF, because that is the format set 
in Lightroom’s External Editing preferences in Lesson 1. 

The TIFF composite is automatically saved to the same folder on your drive as the 
most selected of the component photographs that you opened from Photoshop 
into Lightroom. When you select multiple photographs in Lightroom, the one you 
select first is deemed the most selected photograph, as explained in the “Selecting” 
section in Lesson 3. 

Finish the exercise by returning to Lightroom’s Library module to see there is now 
a TIFF composite in addition to the four component raw files from which the com-
posite was built in Photoshop.

A common question related to this workflow is whether Lightroom retains the 
layers in a composite. The answer is that if you create a composite in this way, 
although you can’t access the layers in Lightroom, they are still there and can be 
accessed in Photoshop. For example, to access the layers of this TIFF composite, 
you could reopen the TIFF composite from Lightroom into Photoshop by choosing 
Edit In > Edit in Photoshop [xx] and then choosing the Edit Original option, which 
is covered in detail in the “Edit Original option” section in Lesson 2.
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Working with embedded Smart Objects

This section demonstrates how and why to place photographs as embedded Smart 
Objects into a layered Photoshop composite that is managed in Lightroom.

An embedded Smart Object is a separate image contained within a Photoshop 
document. Embedded Smart Objects have the following properties that are useful 
in a composite, as this exercise demonstrates:

•	 If a photograph you use in a composite is a raw file (like gordes.dng in this 
exercise), and you place it in a Photoshop composite as an embedded Smart 
Object, double-clicking the Smart Object’s thumbnail in Photoshop’s Layers 
panel opens the photograph into Photoshop’s Camera Raw plug-in (not into 
Lightroom as you might expect). In Camera Raw, you can edit the Smart 
Object layer using Camera Raw controls that are similar to those in Lightroom’s 
Develop module. The benefits of this workflow are that it lets you use familiar, 
intuitive editing controls during the Photoshop phase of the workflow without 
returning to Lightroom’s Develop module for editing at this point, and it lets 
you apply those editing controls to a single layer in a composite.

•	 In addition, you can copy an embedded Smart Object layer, apply different 
adjustments to each copy in Camera Raw, and then blend the results using 
a layer mask. This lets you use Camera Raw as if it were a graduated neutral 
density filter, correcting for varied lighting in different parts of an image, as 
students do in this exercise. 

This exercise starts with opening a background image (so.psd) from Lightroom into 
Photoshop using Lightroom’s Edit In > Edit in Adobe Photoshop [xx] command. 
The composite will be built on top of this background image in Photoshop. The 
background image in this exercise is a blank PSD file, but it could be a photograph 
or image in any format Lightroom recognizes. Starting by opening the background 
image from Lightroom into Photoshop, rather than just opening it directly in 
Photoshop, ensures that at the end of the exercise the composite will be automati-
cally saved back to Lightroom.

Two other photographs (gordes.dng and texture.jpg) are then placed into the base 
image as embedded Smart Objects, each automatically appearing on a separate 
Smart Object layer in Photoshop. If students are on Macs, they can place these two 
photographs by dragging them from Lightroom into the base image that’s open in 
Photoshop. If students are on Windows (which does not support that drag-and-
drop method), they must use Photoshop’s File > Place Embedded command, which 
accomplishes the same thing. Both methods are described in this exercise. 

When the raw file (gordes.dng) is placed, it automatically opens first into 
Photoshop’s Camera Raw plug-in, because it’s recognized as a raw file. Clicking 
the OK button in Camera Raw places this photograph into the base image open 
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in Photoshop. This photograph is placed as an embedded Smart Object on a sepa-
rate layer (the gordes layer). 

When the JPEG (texture.jpg) is placed, it opens directly into the open base image in 
Photoshop as an embedded Smart Object on its own layer (the texture layer). 

Now that all the component photographs are open in a single image in Photoshop, 
common Photoshop compositing techniques are applied. A layer blend mode 
and a layer Opacity adjustment are applied to the texture layer. This blends the 
texture layer with the photograph on the gordes layer below, giving the image a 
texturized appearance. 

The next part of this exercise demonstrates one of the benefits of an embedded Smart 
Object: the ability to open it into Camera Raw to make adjustments there. First, the 
embedded Smart Object layer that was created from the raw file (the gordes layer) 
is copied. It’s important to use the New Smart Object via Copy command rather 
than the Duplicate Layer command for this purpose, so that the Smart Object on 
the gordes copy layer is not linked to the Smart Object on the gordes layer. 

The raw data has been preserved inside the Smart Object on the gordes copy layer 
and can be edited in Camera Raw. So the next step is to open the gordes copy layer into 
Camera Raw and use the simple sliders in Camera Raw to enhance the sky area 
of the gordes photograph, without regard to the effect on the foreground of the 
photograph. The sliders in Camera Raw’s Basic panel are very similar to the sliders 
in Lightroom’s Basic panel, so students should be comfortable using them.

The next step is to use a layer mask in Photoshop to blend the adjusted sky on the 
gordes copy layer with the foreground on the gordes layer. In case students are not 
familiar with layer masking, a “Layer Mask Primer” sidebar is included in this section.

Finally, the composite is saved using the File > Save command so that it automati-
cally appears in Lightroom as a TIFF file, so-edit-P.tiff.

You may have noticed another command in Lightroom’s Edit In menu—Open 
as Smart Object in Photoshop. This command also generates embedded Smart 
Objects, but it was not used in this exercise because it would create a separate 
document in Photoshop for each of the component images. Extra steps would then 
be required to combine the Smart Objects in each of those documents into one 
composite image. If students want to know more about this command, refer them 
to the sidebar “Lightroom’s Open as Smart Object command” in this section.

A note on terminology: Embedded Smart Objects used to be called simply Smart 
Objects. When linked Smart Objects were introduced in an early 2014 version of 
Photoshop CC, Smart Objects were called embedded Smart Objects to distinguish 
them from linked Smart Objects. Linked Smart Objects are addressed in the next 
section of this lesson.
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Working with linked Smart Objects

This exercise teaches students how to use Lightroom and Photoshop together 
with linked Smart Objects. A linked Smart Object is an external file rather than an 
embedded element. It comes in handy for an item you might use in more than one 
composite image, like a logo or a template. The benefit of a linked Smart Object 
is that when you update a linked Smart Object in one image, you can have that 
change ripple through other images that use the same linked Smart Object.

This exercise starts with opening three background images (gold.tif, aqua.tif, and 
purple.tif ) from Lightroom into Photoshop using Lightroom’s Edit In > Edit in 
Adobe Photoshop [xx] command.

The next step is to place another image, logo.psd, as a linked Smart Object in one of 
the background images (gold.tif ). If students are on Macs, they can do this by hold-
ing the Option key and dragging logo.psd from Lightroom into the background 
image that is open in Photoshop—gold.tif. If students are on Windows (which does 
not support that drag-and-drop method), they must use Photoshop’s File > Place 
Linked command, which accomplishes the same thing. Both methods are described 
in this exercise. Once the logo is placed, it can be scaled or transformed multiple 
times without degrading its quality, because it is a Smart Object. Gold.tif, with its 
linked Smart Object, is saved using Photoshop’s File > Save command. Its name 
automatically changes to gold-Edit-P.tif in Photoshop, and it appears in Lightroom 
with the logo element. This file is left open in Photoshop.

The steps in the previous paragraph are repeated twice more with the other two 
background files open in Photoshop—aqua.tif and purple.tif—so the three images 
open in Photoshop contain the same linked Smart Object made from logo.psd. One 
of the three images, purple.tif, is then closed so that later you can use it to show 
how a linked Smart Object in a closed image is treated differently than a linked 
Smart Object in an image that is open in Photoshop.

Next, students make a change to the linked Smart Object in one of the open docu-
ments, gold-Edit-P.tif. This teaches them how to make a pixel-based edit to a Smart 
Object by opening it as a separate document, making the change, and saving.

At this point, students see the big advantage that a linked Smart Object offers. 
The change made to the linked Smart Object in gold-edit-P.tif automatically 
appears in the same linked Smart Object that is in the other open document, 
aqua-edit-P.tif. The point to emphasize is that changing a linked Smart Object in 
one image in Photoshop automatically updates that linked Smart Object in any 
other document that is currently open in Photoshop. However, that is not the 
case for a document that contains the same linked Smart Object but is not open 
in Photoshop. To see that, students return to Lightroom, where the change to the 
linked Smart Object is displayed in two of the three background images. The rest 
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of this exercise demonstrates how to update the linked Smart Object in the docu-
ment that was not open at the time of the change—purple-Edit-P.tif.

As you consider teaching the sections on embedded and linked Smart Objects, 
keep in mind that Photoshop Smart Object technology is a deep topic. If your 
students are Photoshop novices, you may decide to skip the Smart Object sec-
tions of this lesson. If you need more information on Smart Objects, see the Adobe 
Photoshop CC Classroom in a Book (ISBN: 978-032-19280-8).

Creating a 32-bit merged HDR

There are a number of applications and plug-ins that you can use to create a High 
Dynamic Range (HDR) image from multiple photographs. One of the best ways 
to do that is using Lightroom and Photoshop together. The advantages of this 
Lightroom/Photoshop method is that it creates a 32-bit file, which offers the maxi-
mum amount of image data, and that it allows students to use familiar Lightroom 
Develop module controls to tone-map the resulting HDR image.

Explain that although HDR has become associated with a detailed, saturated image 
style, HDR has a more practical purpose too: It allows you to merge multiple 
exposures of the same scene to obtain more dynamic range than your camera can 
capture in just one shot. You can then tone-map the merged image to achieve a 
natural-looking HDR image with lots of detail across the tonal range, in highlights, 
midtones, and shadows.

Walk students through the steps of this technique, which are spelled out in this sec-
tion. Students will use Lightroom’s Edit In > Merge to HDR Pro in Photoshop com-
mand to pass multiple photographs to Photoshop, where they are merged into a 
single HDR image. That image is saved back to Lightroom, where familiar Develop 
module adjustments are applied.

Some points to mention are:

•	 This exercise uses three bracketed photographs, shot in bright sunlight at 2/3 of 
a stop apart. However, the same technique can be done with a different number 
of photographs (5, 7, or even 9 bracketed shots) and with photographs shot at 
different intervals (for example, 1 stop or 2 stops apart). The optimal number of 
shots and intervals depends on the brightness and contrast in the scene and the 
capabilities of your camera. 

•	 Remind students that bracketed shooting for HDR should be done by varying 
shutter speed, rather than aperture, so that all the shots have the same depth 
of field. 
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Merging to a panorama

Photoshop is often used to stitch together multiple overlapping shots of a 
scene that is too wide or tall to capture in one shot. You can take advantage 
of Lightroom’s Develop module controls to prepare photos for merging to a 
panorama and to keep track of the images involved.

In this exercise, students make some adjustments to multiple component 
photographs in Lightroom, using Lightroom’s Sync command to apply the same 
adjustments to all the photographs. They then use Lightroom’s Edit In > Merge to 
Panorama in Photoshop command to pass the photographs to Photoshop, where 
they are stitched together. The resulting panorama is saved back to Lightroom. 
All the steps for this process are spelled out in this section.

Offer students these tips for shooting images they plan to merge into a panorama:

•	 Overlap each shot with the preceding one by about 30 percent of the scene.

•	 Set your camera to manual focus and manual exposure so those parameters 
don’t change as the camera moves through the scene.

•	 Use a tripod if you can, although it is possible to shoot a panorama handheld 
if you’re steady.
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Lesson 6:  
Lightroom to Photoshop for  
Selecting and Masking
Photoshop is often used with Lightroom in order to affect a specific area of a 
photograph by applying selections and masks.

The exercises in Lesson 6 demonstrate common scenarios in which photographs 
are often passed from Lightroom to Photoshop for selecting and masking: changing 
the appearance of part of a photograph, making photo adjustments to specific areas 
with adjustment layers, replacing a dull sky, and selecting and compositing complex 
objects against a background. You can approach each exercise in this lesson as a 
distinct subject.

Preparing for this lesson

This section instructs students to import the Lesson 6 files to the LPCIB catalog. It 
is the same as the section of the same name in Lesson 2 and subsequent lessons.

Why move to Photoshop for selecting and masking

This section sets the stage for the rest of this chapter. It explains why isolating a par-
ticular area for editing is a common reason for using Photoshop with Lightroom.

Granted, there are times when Lightroom’s local adjustment tools are all that’s needed 
to make adjustments to a specific area of a photograph. Lightroom’s Adjustment Brush 
tool allows you to paint adjustments on individual areas, and its Auto Mode feature 
is sometimes sufficient to keep adjustments within the edges of a well-defined object. 
Lightroom’s Spot Removal tool, Radial Filter tool, Graduated Filter tool, and Red Eye 
tool offer other ways to apply adjustments locally in Lightroom. However, Photoshop’s 
selection and masking tools outpace Lightroom’s local adjustment tools in two ways—
precision and functionality—as explained in this section.

Precision means that Photoshop’s sophisticated tools allow you to make more 
controlled, well-defined selections and masks than are possible in Lightroom. 
Functionality means that you can make a wider variety of adjustments and 
enhancements to an isolated area in Photoshop than in Lightroom. 

Making precise selections in Photoshop

This section is a primer on Photoshop selections. It describes how to apply some 
of Photoshop’s most useful selection tools: the Quick Selection tool for automati-
cally selecting objects with well-defined edges, the Polygonal Lasso tool for making 
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straight-edged selections, the Magnetic Lasso tool for selecting complex objects 
with high-contrast edges, and the Pen tool for drawing precise selections. Review 
these sections with students to ensure they are ready to use these Photoshop tools 
in the exercises in this chapter.

The sidebar “Selection shortcuts” lists shortcuts for common selection-related 
functions: deselecting, selecting all, adding to a selection, subtracting from a 
selection, and inverting a selection.

Remind students they can use more than one selection method to make a single 
selection, as described in the sidebar “Using multiple selection tools together.” 

Draw students’ attention to the utility of Quick Mask mode for fine-tuning a selec-
tion, as described in the sidebar “Cleaning up a selection in Quick Mask Mode.”

For more information on selections, refer students to Adobe Photoshop CC 
Classroom in a Book. 

Changing the color of objects with fill layers

The two exercises in this section illustrate that a common reason to take a 
photograph from Lightroom to Photoshop is to make a change to just part of 
the photograph. The changes in these exercises are color changes, but students 
could make many other changes to an isolated area in Photoshop that go beyond 
the photo adjustments available in Lightroom. For example, in Photoshop a 
selected area could be filtered, cut, copied, transformed, and more.

This exercise illustrates two different methods of changing color in Photoshop: 
adding a Solid Color fill layer and applying a Gradient Fill layer.

The lesson files for this exercise are JPEGs, but the principles taught here apply 
regardless of the format of the photograph (raw, TIFF, PSD, PNG, or JPEG). 
For more on working with JPEGs in Lightroom and Photoshop, see the section 
“Starting with a JPEG” in Lesson 2. 

Recoloring with a Solid Color fill layer
In this section, students pass a photograph from Lightroom to Photoshop to add a 
color tint to part of the photograph using a Solid Color fill layer. 

The photograph is handed off with the Edit a Copy with Lightroom Adjustments 
option, which was covered in detail in Lesson 2. The Polygonal Lasso tool is used to 
select a straight-edged area of the photograph to edit. With that selection active, a 
Solid Color fill layer is added. The Color layer blend mode is applied to the fill layer 
to change the effect of the fill layer from a solid color to a tint. The File > Save com-
mand saves the recolored copy of the file back to Lightroom in the TIFF format, in 
accordance with the External Editing preferences set in Lesson 1.
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Use the layer mask that comes with this fill layer to point out the relationship 
between selections and masks in Photoshop. Students may not realize that selec-
tions and masks are essentially two different ways of displaying the same thing— 
an area that has been isolated for editing. 

The layer mask on this fill layer is also an opportunity to revisit how layer masks 
work. Every fill layer comes with its own layer mask. If a selection is active at the 
time a fill layer is created, the area outside the selection is automatically filled with 
black on the layer mask. The black area of the layer mask hides the effect of the fill 
layer from the corresponding part of the image. Adjustment layers and their layer 
masks work the same way, as students will see later in this lesson. For more on layer 
masking see the “Layer mask primer” sidebar in Lesson 5.

Designing with a Gradient Fill layer
This section is similar to the last, except that different Photoshop selection tools 
and a different method of changing color are used here. 

After making a selection of an area to recolor, students apply a Gradient Fill layer. 
They can experiment with the Gradient Editor and Gradient Fill dialog to get a 
sense of the options available there. 

Then students set the blend mode of the Gradient Fill layer to Color to blend the 
color gradient with the selected area of the photograph. They finish by applying the 
File > Save command to save the edited copy of the photograph in the TIFF format. 
Back in Lightroom, the recolored TIFF appears in addition to the original JPEG. 

An important skill for students to develop is anticipating which of Photoshop’s 
many selection methods will be most efficient and accurate for selecting a given 
area. Have students try out several selection methods to make the initial selection 
of the yellow area of the train engine in this exercise. The Pen tool, the Magnetic 
Lasso tool, and the Quick Selection tool are some selection methods to try. Then 
have them practice subtracting the area of the door from the initial selection, using 
a selection tool like the Rectangular Marquee.

Making selective adjustments 
with adjustment layers

This exercise focuses on using Photoshop to adjust a selected area that is too com-
plex to isolate precisely in Lightroom. It also introduces Photoshop adjustments 
layers as a nondestructive workaround for direct pixel editing in Photoshop. 
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Starting in Lightroom
This exercise starts with a raw DNG photograph. Students apply some common 
overall adjustments in Lightroom’s Develop module: adjusting exposure, chro-
matic aberration, and capture sharpening. Then students focus on making local 
adjustments to the foreground elements in the photograph. Although Lightroom’s 
Adjustment Brush tool is a possible candidate for this work, limiting adjustments to 
an object with complex edges, like the statue in this photograph, is often best done 
with selections and masks in Photoshop.

Making an inverted selection in Photoshop
Students use several selection tools to select everything except the statue. That 
selection is then inverted so that only the statue is selected for editing. Make the 
point that it is sometimes easier to select a background and invert that selection 
than it is to select a complex foreground element.

Another teaching point introduced in this section is the importance of saving a 
complex selection so you can quickly use it again if necessary. 

Creating adjustment layers with selections
This section focuses on how to use adjustment layers to edit nondestructively and 
to adjust part of a photograph in Photoshop. 

Remind students that although Lightroom Develop adjustments are nondestructive 
of a photograph because they are just instructions in a database, direct Photoshop 
adjustments permanently change the pixels in a photograph. Photoshop adjustment 
layers are a workaround that allow for nondestructive editing in Photoshop. An 
adjustment layer can be reopened and changed at any time without altering under-
lying pixels, as long as an image is saved from Photoshop in a format like TIFF or 
PSD that retains layers.

Explain that adjustment layers, like fill layers used earlier in this lesson, come with 
their own layer masks. If a selection is active when the adjustment layer is created, 
the area outside the selection is automatically filled with black on the adjustment 
layer mask, hiding the adjustment from the corresponding part of the image.

With the selection made in the last section still active, students create a Levels 
adjustment layer to correct the exposure and contrast of the selected statue. On the 
Levels adjustment layer mask, the area outside the selected statue is automatically 
filled with black, protecting everything except the statue from the Levels adjust-
ment. Once the layer mask is in place, students learn how to access mask options in 
Photoshop’s Properties panel to soften the edge of the mask.

The next part of the exercise reinforces similar concepts, as students select another 
foreground area of the photograph and apply different adjustment layers to that 
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area—a Brightness/Contrast adjustment layer and a Hue/Saturation adjustment 
layer. These steps illustrate that more than one adjustment layer can be applied to 
the same selected area.

The adjusted image is saved using Photoshop’s File > Save command, which creates 
a TIFF copy that is displayed in Lightroom along with the original raw DNG file. 
This is an important step because the saved TIFF is used as the starting point for 
the next exercise in this lesson.

Replacing a dull sky

A common use for Photoshop selections and layer masks is to replace a dull sky 
in a photograph with a more interesting sky. The result is a composite image that 
appears in Lightroom along with the component photographs.

The exercise starts with the edited TIFF saved at the end of the last exercise,  
adj-statue-Edit-P.tif. If students have not saved that TIFF, have them use the lesson 
file sk-statue.tif, which is the same image with all the adjustments from the last 
section incorporated.

Students pass two photographs—the statue and a dramatic, cloudy sky—from 
Lightroom to Photoshop using Lightroom’s Edit In > Edit in Photoshop [xx] 
command with the Edit Original option. This step illustrates how to open multiple 
photographs from Lightroom to Photoshop as separate documents (as opposed 
to opening them as layers in the same document with Lightroom’s Edit in > Open 
as Layers in Photoshop command, as in Lesson 5). 

The next step is to select the entire dramatic sky photograph and copy it into 
memory. Then students click the document tab for the statue image to make that 
image active.

In the last exercise, students created and saved a selection of the dull sky in the 
statue image. In this exercise, they load that saved sky selection back into the 
statue image. If students did not save the sky selection in the last exercise, they 
are instructed to re-create that selection using the Magic Wand tool with the 
Contiguous option unchecked. 

Photoshop’s Edit > Paste Special > Paste Into command is then used to paste the 
dramatic sky from memory into the active sky selection in the statue image. The 
Paste Into command creates a new layer in the statue image with two thumbnails: 
the dramatic sky photograph and a layer mask that is automatically filled with 
white and black. The selected area (the dull sky) is white on the layer mask, reveal-
ing the dramatic sky in place of the dull sky in that area. The nonselected fore-
ground elements (the statue and the stonework) are black on the layer mask, hiding 
the dramatic sky from view there. 
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One of the advantages of using the Paste Into command to accomplish this result 
is that the layer mask created by the command is not linked to the dramatic sky 
image. Point out to students that there is no link symbol between the photograph 
thumbnail and the layer mask thumbnail on the dramatic sky layer, as there is when 
a layer mask is created the conventional way—by clicking the Add Layer Mask icon 
at the bottom of the Layers panel. This allows students to move the sky around with 
the Move tool without disturbing the mask to get just the look they want.

The completed composite is saved using Photoshop’s File > Save command. This 
updates the TIFF with which students started this exercise, so that Lightroom 
now displays the TIFF as a composite of the dramatic sky and the adjusted statue.

Isolating a complex object with a channel mask

This exercise illustrates how to replace the background of a photograph by passing 
the photograph from Lightroom to Photoshop for selecting, masking, and compos-
iting using a channel mask. Although any Photoshop selection method could be 
used with this technique, this exercise teaches a selection method—channel mask-
ing—that is very useful for making selections of complex edges. This is a relatively 
advanced selection technique, so keep your students’ skill levels in mind as you 
decide whether to teach it. 

Before students start this exercise, make sure they read the Introduction to 
Channels sidebar in this exercise, which explains color channels in an RGB image.

Then walk students through the steps of this exercise, which demonstrate how to 
use a channel as the basis for a channel mask, which is used to create a selection 
and ultimately a layer mask. The following summarizes the steps (which are spelled 
out in more detail in the book):

1	 Pass two TIFF photographs from Lightroom to Photoshop—a photograph of a 
dog that contains a studio background, and a photograph of an outdoor scene—
using Lightroom’s Edit In > Open as Layers in Photoshop command.

2	 In the resulting Photoshop document, make sure the photograph of the dog is 
at the top of the layer stack in the Layers panel.

3	 Evaluate the red, green, and blue color channels in the dog image to find the 
color channel with the most contrast (the most difference between light and 
dark values). In this case, the highest contrast channel is the Red channel.

4	 Duplicate the high-contrast Red channel to create the Red copy channel. The 
Red copy channel is not a color channel like the red, green, and blue channels. 
It is an alpha channel, which is a special kind of channel whose function is to 
contain a mask. 
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5	 Apply a Levels adjustment to the Red copy channel to increase the contrast in 
that channel so that it makes a better mask. 

6	 Make a rough selection just inside the edge of the dog. On the Red copy 
channel, paint with black inside that selection so that the area inside the dog is 
black and the area outside the dog is white on the channel mask you’re creating. 

7	 If students zoom into the channel mask, they’ll see that its extreme edges are 
gray. This is a good idea with a soft object like this dog’s fur, because the gray 
at the edges of this mask soften the mask so that the dog will blend better 
with its replacement background. Mention that if an object has a hard edge, a 
channel mask can sometimes be improved by painting over the edges with black 
or white paint and a soft Brush tool set to Overlay blend mode. The Overlay 
blend mode would cause the Brush tool to darken (with black paint) or lighten 
(with white paint) only the gray areas of the channel mask, without disturbing 
existing areas of black or white on that mask. This would harden the edge of the 
channel mask. 

8	 When the channel mask is complete, use it to generate a selection by Ctrl-
clicking/Command-clicking the Red copy channel. This further illustrates the 
point that a mask is another way of representing a selection.

9	 Invert the selection so that only the dog shape is selected.

10	 With the selection of the dog active, in Photoshop’s Layers panel create a layer 
mask on the layer that contains the photograph of the dog. The layer mask 
reflects the selection made from the channel mask. On the layer mask, the 
selected dog is white, the nonselected background is black, and the transition 
edges of the dog’s fur are gray. The black area on the layer mask hides the studio 
background of the photograph of the dog, revealing the outdoor scene on the 
layer below.

11	 Summarize for your students what they’ve done so far. They’ve used a color 
channel to create a channel mask in an alpha channel, generated a selection 
from the channel mask, and converted the selection into a layer mask that 
hides the studio background on the dog photograph, revealing a different 
background photograph.

The next steps are optional, but fun. They illustrate how to use a specialty grass-
shaped brush on another layer mask to add some grass on top of the dog’s feet.

12	 Save the finished composite using Photoshop’s File > Save command. In 
Lightroom, the TIFF of the dog updates to display the composite you created 
with masks and selections in Photoshop.
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Selecting hair

This exercise moves a portrait from Lightroom to Photoshop in order to place the 
subject against a new background. Hair, animal fur, or other soft-edged, complex 
objects are difficult to isolate in Lightroom. So Photoshop is the best place to do 
this, whether your goal is to include the subject in a composite as in this exercise or 
just to limit an adjustment to the soft-edged subject.

Students start this exercise by passing two PSDs—a photograph of a curly-haired 
model with a plain white background and a photograph of a bokeh light pattern—
from Lightroom to Photoshop. They combine the two photographs into a composite. 

The next step is to make a rough selection of the model. The trick is to omit from this 
initial selection the edges of the hair through which the white background is showing. 
This will help the Refine Selection Edge feature do its job in the next steps.

Most of this exercise takes place in Photoshop’s Refine Selection Edge dialog. The 
exercise walks students through the features of this dialog, showing them how to use 
it to fine tune a soft-edged, complex selection like hair. The result is output as a new 
layer with a layer mask that hides the white background on the model layer, revealing 
the model and her curly hair against the bokeh light pattern on a layer below.
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Lesson 7:  
Lightroom to Photoshop for Retouching
Photoshop is the go-to application for all kinds of retouching, from portrait refine-
ment, to moving objects, to removing content, to adding special effects like custom 
blurs. Each exercise in this chapter illustrates a different situation in which you 
might pass a photograph from Lightroom to Photoshop for retouching.

Preparing for this lesson

This section instructs students to import the Lesson 7 files to the LPCIB catalog. It 
is the same as the section of the same name in Lesson 2 and subsequent lessons.

Removing and moving objects

In this section, students change the content of a photograph by moving and remov-
ing elements.

Starting in Lightroom
The first steps in the exercise illustrate that you can sometimes successfully remove 
unwanted content using the Spot Removal tool in Lightroom’s Develop module. 
Students use that tool in Lightroom to remove some unwanted grass in a photo-
graph of sheep in a field.

However, Photoshop offers more options for changing content than Lightroom 
does. Photoshop has several sophisticated retouching features, including the Spot 
Healing Brush tool, the Healing Brush tool, the Patch tool, and Content-Aware 
Fill. It also has a special tool, the Content-Aware Move tool, for moving items in a 
photograph, which is something you can’t do in Lightroom. To take advantage of 
some of those Photoshop features, students pass this PSD format photograph from 
Lightroom to Photoshop using Lightroom’s Edit In > Edit in Adobe Photoshop [xx] 
command with the Edit a Copy with Lightroom Adjustments option.

Moving content in Photoshop
In this section, students use Photoshop’s Content-Aware Move tool to change 
the location of an object—a lamb—in this photograph. Remind students that the 
Content-Aware Move tool works best if you don’t try to move an object too far and 
if the surrounding area has a uniform texture, like the grass in this photograph.
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Students use two options with the Content-Aware Move tool in this exercise: 

•	 Students make a separate layer for this change and check the Sample All Layers 
checkbox in the tool’s Options bar. This nondestructive editing technique 
protects the pixels of the photograph and gives the user the flexibility to edit or 
even delete the changes on the separate layer. 

•	 Students also work with the Adaptation option to control how the moved object 
blends with the surrounding area.

Remind students to leave the photograph open in Photoshop for the next section.

Removing content in Photoshop
In the next sections, students use several content-aware features to remove ele-
ments from the photograph by hiding them with content sampled from elsewhere 
in the image. The content-aware technology built into these features helps blend 
the sampled content with the surrounding area. 

Content-Aware Fill

Students select some unwanted content in the photograph, invoke the Edit > Fill 
command, and set the Use menu in the Fill dialog to Content-Aware. This causes 
Photoshop to fill the selection with content it automatically samples from outside 
the selection. 

Make sure that students select the Background layer that contains the photograph 
before applying this command. Content-Aware Fill cannot be performed on a 
separate layer like other retouching methods. Content-Aware Fill is a destructive 
method that changes the pixels of the photograph. For that reason, some photog-
raphers copy the layer containing the photograph before applying Content-Aware 
Fill, although that protective step can increase file size significantly.

The Patch tool

Photoshop’s Patch tool is another useful method of hiding selected content. 
Students select an area to remove and use the Patch tool to drag that selection to a 
source area of good pixels. When the mouse is released, Photoshop samples pixels 
from the source area, uses them to patch over the original selected area, and blends 
the patch with the surroundings. 

Three options are used with the Patch tool in this exercise:

•	 Students should choose Content Aware from the Patch menu in the Patch tool’s 
Options bar. This will cause the patch to blend with the surrounding area. 

•	 Students should check the Sample All Layers option in the Patch tool’s Options 
bar and create a separate layer for the patch—a recommended nondestructive 
editing technique. Note that the Sample All Layers option only appears in the 
Options bar if the Content Aware option has been selected. 
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•	 Students can experiment with the Adaptation menu choices to make the patch 
look as natural as possible.

The Healing tools

Photoshop’s Spot Healing Brush tool and Healing Brush tool are often used for 
retouching, so students should become familiar with them. The main difference 
between these tools is that the Spot Healing Brush tool automatically samples heal-
ing pixels from the surrounding area, whereas the Healing Brush tool requires the 
user to manually sample healing pixels. So the Spot Healing Brush tool is quicker 
to apply, but the Healing Brush tool gives the user more control and can be more 
accurate. Both tools are content-aware and blend the healing pixels with the sur-
rounding area.

The steps in this section of the exercise walk students through using both the Spot 
Healing Brush tool and the Healing Brush tool to hide content in this photograph.

After all these edits have been made to this photograph in Photoshop, the File > 
Save command is applied. This saves the edited photograph as a TIFF file in accor-
dance with Lightroom’s External Editing preferences, places the edited TIFF in the 
same folder as the original PSD file, and displays the TIFF in Lightroom along with 
the original PSD. 

Sculpting a portrait

Portrait retouching has traditionally been done in Photoshop, so photographers 
often pass a photograph that is managed in Lightroom to Photoshop for retouch-
ing. However, Lightroom’s local adjustment tools can accomplish some portrait 
editing too, as students experience in this exercise.

Starting in Lightroom
This exercise starts with a PSD format portrait in Lightroom. Students use 
Lightroom’s Adjustment Brush tool to paint over and soften the model’s skin by 
dragging the Clarity slider to a negative value. Point out that Lightroom is using a 
mask to isolate the area affected by the Adjustment brush. The Adjustment brush 
is set to the Erase option to omit from the negative clarity mask the eyes, mouth, 
and other facial features that should stay sharp.

Lightroom’s Edit In > Edit in Adobe Photoshop [xx] command with the Edit a 
Copy with Lightroom Adjustments option is used to pass the photograph, with 
its Lightroom adjustments, over to Photoshop for more retouching.
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Applying the Liquify filter in Photoshop
Changing the shape of a model’s features is something that can be accomplished 
only in Photoshop, not in Lightroom. Access to Photoshop’s Liquify filter is reason 
in itself to transfer a portrait from Lightroom to Photoshop.

In this section, students use several tools and options in the Liquify filter dialog 
to fine-tune this portrait. Make sure students follow the instructions for applying 
Liquify as a Smart Filter so that the changes they make with it remain re-editable.

Retouching after applying Liquify as a Smart Filter 
This section illustrates another consequence of using Liquify as a Smart Filter—
pixel retouching can no longer be done directly on the photograph because it is 
now a Smart Object. In this section students learn how to make pixel-level changes 
to a Smart Object. They open the Smart Object as a separate document (a PSB file) 
in Photoshop, and then use Photoshop’s Healing Brush tool to reduce puffiness 
under the model’s eyes, remove blemishes, and hide unwanted hairs. 

Remind students to use the File > Save command, rather than the Save As com-
mand, to save the edited PSB file. The changes made to the PSB file will now appear 
in the original PSD photograph in Photoshop. 

The File > Save command is applied again to save the photograph, with all its edits, 
as a TIFF copy, in accordance with Lightroom’s External Editing preferences. The 
edited TIFF appears back in Lightroom along with the original PSD.

Adding complex blur

Changing the appearance of a photograph is another form of retouching. 
Sophisticated filters are among the many changes that can be made in Photoshop, 
but not in Lightroom. In this exercise, students pass a photograph from Lightroom 
to Photoshop to apply complex photographic blur effects using various Photoshop 
blur filters.

Applying iris blur
The first exercise in this section starts with a beach photograph in PSD format that 
is passed from Lightroom to Photoshop using Lightroom’s Edit In > Edit in Adobe 
Photoshop [xx] command with the Edit a Copy with Lightroom Adjustments option.

In Photoshop, the photograph is converted for Smart Filters so that filter effects 
applied to it can be re-edited if necessary. This process converts the photograph 
to a Smart Object.
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Photoshop’s Iris Blur filter is then applied in a way that adds multiple points of 
focus and blurs other areas for an intriguing look that could not be achieved in 
camera. Allow students to experiment with the Iris Blur filter options to change 
the look of the photo.

Remind students that because the photograph was converted for Smart Filters it 
is now a Smart Object. Therefore, any further pixel editing they may wish to do 
with other Photoshop tools cannot be done directly on the photograph. Instead, 
they will have to open the Smart Object as a separate PSB document, edit the PSB, 
and then use the File > Save command, just as in the preceding portrait retouching 
exercise. This gives students another opportunity to practice working with sophisti-
cated Smart Objects in Photoshop.

To finish the exercise, students use Photoshop’s File > Save command to save the 
edited image as a TIFF, in accordance with Lightroom’s External Editing prefer-
ences. The edited TIFF is displayed in Lightroom along with the original PSD.

Creating tilt-shift blur
The second exercise in this section works much like the preceding exercise, except 
that it uses a different blur filter in Photoshop: the Tilt-Shift Blur filter. This filter 
makes large objects in a scene, like this cityscape, look like miniatures. 

Students again pass a photograph from Lightroom to Photoshop and convert it for 
Smart Filters. Let students experiment with the options for Photoshop’s Tilt-Shift 
Blur filter. They’ll again save the edited photograph back to Lightroom as a TIFF 
copy of the original. 
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Lesson 8:  
Lightroom to Photoshop for Special Effects
Most of the changes you can make to a photograph in Lightroom involve adjust-
ments to photo quality. Photoshop offers a wider range of features for embellishing 
photographs with filters, text, graphics, and other design elements. The ability to 
enhance photographs with effects like these is another major reason to pass photo-
graphs from Lightroom to Photoshop, as students do in this lesson.

Preparing for this lesson

This section instructs students to import the Lesson 8 files to the LPCIB catalog. It 
is the same as the section of the same name in Lesson 2 and subsequent lessons.

Combining text and images

In this exercise, students combine a photograph with text and graphics to create a 
book cover. This exercise brings together skills covered earlier in the book with some 
additional, useful Photoshop skills to create a sophisticated, photo-based design proj-
ect. This project is more complex than other exercises in the book, so it is best taught 
near the end of your course, after students have absorbed the other lessons.

Using Lightroom’s Open as Layers in Photoshop command
Students start by handing off three photographs from Lightroom to Photoshop 
using Lightroom’s Edit In > Open as Layers in Photoshop command. This com-
mand was introduced in Lesson 5 in the context of making a wedding composite. It 
can be used with raw files, like the three DNG lesson files for this exercise, or with 
any of the other still formats that Lightroom recognizes—TIFF, JPEG, PSD, or PNG.

The Open as Layers in Photoshop command is useful because it automatically 
places each selected photograph on a separate layer in the same document in 
Photoshop, saving the step of combining photographs manually in Photoshop. 
It also will result in a single image automatically saved back to Lightroom at the 
end of this exercise.

Creating a book cover composite in Photoshop
In this section, students create a blended composite of the photographs they passed 
from Lightroom to Photoshop. 

First students work with the layers, applying the following layer-related techniques:

•	 Changing layer order

•	 Converting a layer to a Smart Object
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•	 Applying a layer blend mode

•	 Duplicating a layer

•	 Linking layers

Then students crop the image in Photoshop. There are several points to emphasize 
regarding cropping:

•	 Remind students to deselect the Delete Cropped Pixels checkbox in the Crop 
tool’s options bar before cropping so that the crop is nondestructive and 
re-editable. 

•	 When students are sizing the crop box, an info display appears near the cursor. 
If the info display shows the size of the crop box in inches rather than pixels, set 
it to pixels by doing the following: 

1	 Click the Cancel button in the Crop tool’s options bar to cancel the crop. 

2	 Choose Edit/Photoshop > Preferences > Units & Rulers. 

3	 Set the Rulers preference to Pixels. Click OK to close Preferences. 

4	 Create another crop box with the Crop tool. The info display should now 
show the size of the crop box in pixels. 

5	 Refer to that info display to size the crop box to approximately 2675 pixels 
high. This measurement does not have to be exact. 

•	 Students are instructed to drag the image to reposition it within the crop box. 
Point out that this does not move the crop box, as they might expect; it moves 
the image instead. Click inside the crop box and drag to position the image in 
the crop box as illustrated in this section of the book. 

Students then apply Photoshop’s File > Save command to save the composite so 
that it appears as a TIFF in Lightroom, in accordance with Lightroom’s External 
Editing preference for format that was set in Lesson 1. This image should be left 
open for the next part of this exercise.

Adding and styling type layers
In this section, students add text to the book cover composite they started creating 
in the last section. 

Adding text can be tricky. Add the following information if necessary:

•	 The type tool to use for this exercise is the Horizontal Type tool. If it is not 
showing in the Tools panel, click whichever type tool is showing, and choose 
Horizontal Type tool from the flyout menu.

•	 If Arial Black does not appear in the Font menu in your Horizontal Type tool 
options bar, choose Arial Black or Arial Black Regular.
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•	 After adding and positioning the AREA text, reselect the Horizontal Type tool 
in the Tools panel so you’re ready to add the 271 type layer. 

•	 After adding the text, you may have to scale it down to fit your cropped image. 
If so, Ctrl-click/Command-click to select both the AREA and 271 type layers in 
the Layers panel. With the Move tool selected, a transform box appears around 
all the text. (If you are using Arial Black Regular, make the text smaller by 
holding the Shift key as you drag from a corner anchor point of the transform 
box toward the center of the text.) 

A selection is made of the sky and a layer mask is added to hide the text over the sky.

Then a Drop Shadow layer style is added to the text. After setting options for the 
drop shadow, click OK to close the Layer Style dialog.

A Color Fill layer is added, and its layer mask is adjusted in the Properties panel. 
To open the Properties panel, click its icon in the inner panel bar or choose 
Window > Properties.

The next steps teach a useful technique for filling text with a photograph. The 
AREA type layer is used as a clipping mask that makes the razorwire photograph 
visible only inside the letters of the word AREA. 

The File > Save command is applied again at the end of this section. This updates 
the edited TIFF composite displayed in Lightroom. Students should leave this 
image open in Photoshop for the next section of the exercise.

Adding a vector graphic
In this section, students practice adding a graphic on a Shape layer. This kind of 
graphic is vector based, so it has smooth edges and can be resized without degrad-
ing its quality. Photoshop comes with lots of custom shapes to choose from, includ-
ing the radioactive warning shape used in this exercise.

Students select the Custom Shape tool from a flyout menu of shape tools in the 
Tools panel. Then they choose a custom shape and other options in the options 
bar. Be sure they follow the instruction to set the first menu on the left side of the 
options bar to the Shape option. That will cause Photoshop to create a separate, 
editable Shape layer automatically when they drag in the image to create the shape.

Students then fine-tune the shape, using the Move tool to position it in the design, 
adding a blend mode to the Shape layer, applying the Free Transform command 
to resize the shape, and copying the Drop Shadow layer style from the AREA type 
layer to the Shape layer.

Next, students make a selection and add a Color Fill layer by clicking the Create 
New Fill or Adjustment Layer icon at the bottom of the Layers panel, choosing 
Solid Color, and choosing black in the Color Picker that opens.
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Type layers are added with the author’s name and the book’s tagline. The text is 
right justified using the Right Align icon in the Horizontal Type tool’s options bar 
and is positioned using the Move tool. If students are having trouble creating two 
type layers near each other, suggest that they hold the Shift key as they click in the 
image to start the second type layer.

The composite image is saved one last time with the File > Save command. In 
Lightroom the TIFF composite is displayed with all the enhancements added in 
Photoshop. If students want to change something in the composite, they can access 
its layers again by reopening it from Lightroom to Photoshop using Lightroom’s 
Edit In > Edit in Adobe Photoshop [xx] command with the Edit Original option. 

Creating type on a path

Photoshop offers much more flexibility than Lightroom when it comes to add-
ing text and other design elements to a photograph. In the last section, students 
practiced using Photoshop layer masks, blend modes, and layer clipping masks 
to integrate text with photographs. This section teaches another way to use type 
in Photoshop that can’t be done in Lightroom—adding text along a path. 

Creating a rounded border in Lightroom
Although Lightroom’s graphic capabilities are limited, some of its features can 
be used in creative ways to embellish photographs. For example, in this section 
students use the Post-Crop Vignetting controls in Lightroom’s Develop module 
to create a rounded border around a photograph, even though this feature was 
originally designed for a different purpose (to add a light or dark vignette to a 
photograph that would survive subsequent cropping in Lightroom). 

There’s not much that can be done with text in Lightroom beyond some lim-
ited options to add lines of text to a print layout in Lightroom’s Print module. 
So students pass this photograph, with its rounded border, from Lightroom to 
Photograph to add decorative text appropriate for a promotional photograph.

Using vector shapes to place type on a path
The first step in Photoshop to place type on a path is to create a vector path using 
one of Photoshop’s geometric shape tools—the Ellipse tool. 

This Ellipse tool is located in the flyout menu of Shape tools in Photoshop’s Tools 
panel. Caution students not to confuse it with the Elliptical Marquee selection tool, 
located closer to the top of the Tools panel.

Make sure students set the first menu on the left side of the Ellipse tool’s options 
bar to Path, rather than Shape or Pixels.
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Follow the instructions in this section to create a closed, oval path around the hot 
air balloon in the photograph. Note that to finish drawing the path, the mouse but-
ton should be released before releasing the Alt/Option key.

At this point, the path is a temporary work path. To convert it to a regular path, 
students open Photoshop’s Paths panel and double-click the bar in the Paths panel 
that represents this path. Clicking OK in the Save Path dialog that opens saves the 
path. The path should remain selected in the Paths panel while students add type 
along its curvature.

To add text to the path, students select the Horizontal Type tool in the Tools panel 
and hover over the path in the image until they see the type-on-a-path cursor, 
which features a dotted, curved line under an I-beam. Then they click on the path 
and add text. 

Adjusting the position of type on a path
The type may not be in the proper position on the path yet. This section illustrates 
how to move type into the desired place on the path using the Path Selection tool 
(informally known as the black arrow tool).

If the type can’t be moved further along the path, look for the small x on the path, 
and use the Path Selection tool to move it along the path, making more room to 
continue to move the type.

Changing the size of a type path
One of the benefits of type on a path is that after type is applied to a path, the path 
can be resized, reshaped, and repositioned, and the text it contains will follow and 
reflow along the path. In this section, students change the size of the path, using the 
Free Transform Path command, to accommodate larger text.

At the end of this section, Photoshop’s File > Save command is used to save the file, 
which appears as a TIFF in Lightroom.

Applying artistic filters

This section emphasizes that while Lightroom is great for enhancing photo quality, 
Photoshop allows you go beyond the purely photographic, adding artistic and dec-
orative elements to your photographs. Photoshop has numerous creative features 
to explore, among them the many filters you can apply to photographs.
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Creating a radial motion blur
In this section, students make some basic adjustments to a raw file in Lightroom’s 
Develop module. They use Lightroom’s Spot Healing Brush tool to remove some 
unwanted content. Then they pass the file from Lightroom to Photoshop to add a 
unique effect that could not be achieved in Lightroom—a spinning motion effect 
created with Photoshop’s Radial Blur filter.

The edited image is saved from Photoshop as students have done throughout this 
lesson and is automatically added to the Lightroom catalog.

Creating a custom blend of the Oil Paint Filter
In this section, students pass a photograph from Lightroom to Photoshop for appli-
cation of a realistic Oil Paint filter in Photoshop.

Unfortunately, in a recent update to Photoshop CC, the Oil Paint filter was 
removed from Photoshop. So you may want to use this exercise as an opportunity 
for students to explore other artistic filters in Photoshop.

Alternatively, if your students want to try this exercise with the Oil Paint filter, they 
can do so in Photoshop CS6. At this time, users with a Creative Cloud membership 
still can download Photoshop CS6 from the Creative Cloud (by filtering the Apps 
section of their Creative Cloud application to display Previous Versions) and run 
Photoshop CS6 on the same computer as Photoshop CC. 

Exploring the Solarize filter for black and white images
This exercise introduces some unique effects of Photoshop’s Solarize filter on 
black and white photographs. The exercise starts with a raw file that has already 
been converted from color to black and white in Lightroom’s Develop module. 
Students pass the black and white photograph from Lightroom to Photoshop using 
Lightroom’s Edit In > Edit in Adobe Photoshop [xx] command. After applying a 
Solarize filter effect, Photoshop’s File > Save command is used to save the file back 
to Lightroom.

Students can experiment with a color version of the same photograph to see how 
Photoshop’s Solarize filter looks on color photographs. To do that, before pass-
ing the original raw file to Photoshop, open the Snapshots panel in Lightroom’s 
Develop module, and select the Import snapshot. This converts the photograph 
back to color, and it can be passed in that state from Lightroom to Photoshop for 
application of the Solarize filter there. 
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